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1 About Clublink

Clublink makes information easily accessible and provides the necessary tools for the operations of your club.
This program is designed to simplify the day-to-day administration of your club with the ability to import and
export data to your Central Office (governing body) if you have one.

More specifically, you can use Clublink to record all of your member's personal information, registration details
and fees (which may be determined by your Central Office) and payments.  Complete schedules for your club can
also be created allowing you to register members in classes, assign teachers and charge appropriate fees for each
class.  Extensive reporting options are also available for detailed reports on your membership data.

1.1 This Manual

This manual contains complete step-by-step instructions for all aspects of Clublink and includes descriptions or
explanations of each feature.

This information has been divided into five main sections as follows:

Introduction
Setting Up Your Clublink – customizing Clublink to suit your needs
Day-to-Day Clublink Operations – Clublink functions used on a regular (daily) basis
Special Clublink Operations – Not as frequently used functions
For Central Offices Only – Instruction for functions used by Central Offices

Conventions used in this manual:

Þ Indicates step-by-step instructions for Clublink.

Bold Bold text indicates Clublink specific terms.

+Note+: Indicates an important tip in a set of instructions.

1.2 Minimum System Requirements

Þ Any Microsoft® Pentium operating system with Windows® 98 or newer.
Þ A minimum of 15 MB of available hard drive space.
Þ 64 MB RAM.

1.3 Recommended System Requirements

Þ Windows® XP or Windows® 2000.
Þ 100 MB of available hard drive space.
Þ 256 MB RAM.
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1.4 Installation Procedure

If the Clublink 30-day evaluation is already installed:

Þ Insert the CD and install the Unlock Evaluation Mode.
Þ Run Clublink and enter your serial number using your Installation Key.

If Clublink is not already installed:

Þ Insert the CD and install the Clublink Full Installation.
Þ Remove the CD and reboot your computer.
Þ Run Clublink and enter your serial number using your Installation Key.

+Note+: If you have a Central Office Setup Disk or you are Importing Data see
Receive Central Office Setup Disk and Import Club Data.

2 Clublink Application Launcher

Application Launcher is used to start the various Clublink Applications available to you.  Access Clublink
Application Launcher by double clicking on your Clublink icon on your desktop or by selecting Clublink on
your Start Menu and then selecting Application Launcher.    You can choose to Close Automatically, Minimize
Automatically or Leave Open Application Launcher after you have opened a program.  Use the Options menu in
Application Launcher to indicate your preference.  Below is a brief description of each program selection in
Application Launcher.

Clublink – Click on Clublink – The Leader in Integrated Sports to open Clublink

Setup Wizard – A 7 step process that allows you to quickly set-up many defaults for your Clublink program.  We
suggest that you use Setup Wizard as the first step to getting started with Clublink.

+Note+: Clublink must be closed when using Setup Wizard.

One Step Backup – allows you to backup all of your Clublink data with the click of one button.
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Utilities – allows you to perform various maintenance tasks on your Clublink database.

+Note+: Clublink must be closed when using Clublink Utilities.

Task Manager – allows you to perform specific tasks such as importing or exporting data to the web, creating a
web page that includes your class schedules, generating an email list from a group of members, etc.

Chit System – designed for quick assessments of fees.  Primarily designed for social clubs that use a chit system
rather than accepting cash.

Cue Card Tour – a brief overview of Member Level, Class Level, finances and advanced features of Clublink.

Features Tour – a visual tour of Clublink's features that includes screen shots.

3 Setup Wizard

Þ Ensure Clublink is not running.
Þ From the Application Launcher, choose Setup Wizard.

See
Page 2 - General Settings
Page 3 - Data Disks
Page 4 - Data Fields
Page 5 - Custom Drop Down Lists
Page 6 - Linked Registration Options
Page 7 - Miscellaneous

3.1 Page 2 - General Settings

Þ Enter your default area code, province, country and sport.

3.2 Page 3 - Data Disks

See
Central Office Setup Disk
Import Club Data

3.2.1 Central Office Setup Disk

If you have a governing body using Clublink, they will provide you with a setup disk/file that includes
registration categories and fees for your members.  This disk/file will also setup your Clublink to show which
data fields are required and requested by your Central Office.

Þ If you have a setup disk, choose Have Disk and proceed with the on screen instructions.  Detailed
instructions for Receiving Central Office Setup Disk can be found later in this manual.

Þ If you do not have a setup disk, contact your Central Office.
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3.2.2 Import Club Data

You may import your existing club from your Central Office.

Þ If you have a data disk, choose Have Disk and proceed with the on screen instructions.  Detailed instructions
for Importing Club Data from your Central Office can be found later in this manual.

Þ If you do not have a data disk, proceed to page 4.

3.3 Page 4 - Data Fields

The tabs across the top show you the 5 roles of members in Clublink (Competitive, Recreational, Coach, Judge,
Member)

At this point you have the opportunity to specify which data fields you would like to use for each role of
members.  Don't worry if you aren't sure yet, you can always come back to the Setup Wizard and make changes.

By placing a Ö in the box you will make that data field available to enter information.  If you do not have a Ö in
the box, that data field will not be visible when using Clublink.

If you see a Ö that is greyed out, you cannot remove it as it is a data field required by your Central Office.

Clicking on a ? beside the data field will give you a brief description of what the data field is used for.

Þ Click on each of the five tabbed pages and select the data fields that you wish to use.

See
Data Fields

3.4 Page 5 - Custom Drop Down Lists

Two Custom Drop Down Lists are provided for each Role.  The General Tab page for each member will have
the Custom Drop Boxes.  Here you can track specific items for each member. This will assist you with reporting
and management of your members. (ex: how the member found your club).

+Note+: If a Custom Drop Down List is yellow, it has been defined by your Central Office and cannot be
modified.
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Þ Select a Role.
Þ Enter a title for each Custom List Title Box.

See
Adding a list item
Modifying a list item
Deleting a list item

3.4.1 Adding a list item

Þ Click Add.
Þ Type the list item name in the box.
Þ Click Add again to add another list item.

3.4.2 Modifying a list item

Þ Select the list item you wish to change.
Þ Click Modify.
Þ Type the new list item name.
Þ Choose Yes when asked if you would like to update all members.

3.4.3 Deleting a list item

Þ Select the list item you wish to delete.
Þ Click Delete.
Þ Choose Yes when asked if you would like to update all members.

3.5 Page 6 - Linked Registration Options

Linked Registration Options gives your Central Office the opportunity to create categories for your members,
assign fees to those categories and assign minimum and maximum age requirements for those categories If a
Lined Registration Option List is yellow, it has been defined by your Central Office and cannot be modified.
You can assign your own club fees to compliment your Central Office fees, you can also assign sub categories if
they are unused by your Central Office.  If you do not have a Central Office, you can setup your own categories,
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fees and age requirements.

Each Role can have categories (linked list #1), sub categories (linked list #2) and sub sub categories (linked list
#3).

+Note+:  Each selection in Linked List #2 and #3 will be dependant on the selection in Linked List #1.   When
determining registration fees, Clublink will look for the first non-zero registration fee moving from right to left.

Linked List #1

Þ Select a Role.
Þ Type the title of Linked List #1 in the Title box (even if your Central Office has set up this list, you

can type in your own title).
Þ Click in the List Items column under Linked List #1.
Þ Click Add to add a category to the list (if your Central Office has set up this list, you will not be able

to add another category).
Þ Type the List Item name and enter the appropriate ages and fees in the boxes.

+Note+:  You can view the structure of your linked lists by clicking the Hide/Show button at the bottom
right of the screen.  You can also view the details of your linked lists by clicking the Details button.

Linked List #2

You can set up sub categories for each category in your Linked List #1.

Þ Select a Role.
Þ Click on a category in Linked List #1 for which you want to create sub-categories.
Þ Click on the Linked List #2 column and then click Add near the bottom of the screen.
Þ Enter the name, ages, and fees and click OK.  You will notice the your new sub category on the

tree diagram to the right of your linked lists.

Linked List #3

You can add sub categories to your Linked List #2 categories in the Linked List #3 column.  Follow the
same steps as you did for Linked List #2.
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3.6 Page 7 - Miscellaneous

See
Accounts
Custom Edit, Check and Date Boxes
Payment Types
Credit Card Types

3.6.1 Accounts

Clublink allows you to track financial information in 3 different accounts for each member (ex. General, Travel,
Fundraising).

Þ Type the name of each account in the boxes provided at the top left of the screen.

+Note+:  You do not have to name all 3 if you won't be using them all.

3.6.2 Custom Edit, Check and Date Boxes

For each Role, you have six custom boxes available on your registration form.

Custom Edit Boxes are used to type any information you would like to include for your members that you
haven't already recorded in the data fields. (ex. Cell phone number)

Custom Check Boxes give you the opportunity to create your own check boxes for each role. (ex. Preferred
membership status)

Custom Date Boxes are used to record dates that are not already recorded in the data fields. (ex. Anniversary
date)

Þ To set up your custom boxes first select the appropriate Role from the tabbed pages.
Þ Decide on the type of boxes you want to create and then enter their names in the boxes.
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+Note+:  Select these Extra Boxes on Page 4 of the Setup Wizard in order for them to show up on your
registration form in Clublink.  They are located under the Miscellaneous section on the Data Fields page of Setup
Wizard.

3.6.3 Payment Types

Under Payment Types you must setup which methods of payments you will be accepting from your members.
(ex. Cash, Cheque, Credit Card, Debit)

Þ To add a payment type click the Add button and type the name of the payment in the list item box.
Þ If you wish to record a credit card type, number and expiry for this payment type, put a Ö in the Use Credit

Card List box.  If this is not a credit card, leave the checkbox blank and click OK.
Þ Click Add again to enter another payment type.

3.6.4 Credit Card Types

Under Credit Card Types you can add the types of credit cards you will be accepting (ex. VISA, MasterCard,
American Express).  This selection will appear in Clublink only when you have selected Use Credit Card List
when entering the payment type.

Þ You can add your credit card types by clicking the Add button and typing the name of the credit card.
Þ Click Add again to enter another credit card type.

4 Setup Options - Found in Clublink

Under System Setup you can make font selections and colour selections.
Þ From the Options menu on the Clublink Opening Screen select System Setup.
Þ Select each of the menu items to customize Clublink's appearance to your liking.

See
Administrator Password
Read-Only Password
Language
Tax System
Member Reports – Waiver Forms

4.1 Administrator Password

The administrator password protects your data by only allowing those who know the password to access Clublink
on your computer.

Setting the Administrator Password

Þ From the Options menu on the Clublink Opening Screen select Administrator Password.
Þ Select Set.
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Þ Enter the Password and click OK.
Þ Re-enter the Password and click OK.

Turning the Administrator Password On or Off

Þ From the Options menu on the Clublink Opening Screen select Administrator Password.
Þ Select Enable to turn the Password ON, select Disable to turn the Password Off.

+Note+:  To enable the password you must re-enter your password or set a new password.

4.2 Read-Only Password

The read-only password is used in conjunction with the administrator password.  The read-only password allows
users to view Clublink data but does not allow them to change any data.  The Add/Modify/Delete buttons are
disables when a user acceses Clublink with the read-only password.

Setting the Read-Only Password

Þ From the Options menu on the Clublink Opening Screen select Read-Only Password.
Þ Select Set.
Þ Enter the Password and click OK.
Þ Re-enter the Password and click OK.

Turning the Read-Only Password On or Off

Þ From the Options menu on the Clublink Opening Screen select Read-Only Password.
Þ Select Enable to turn the Password ON, select Disable to turn the Password Off.

+Note+:  To enable the password you must re-enter your password or set a new password.

4.3 Language

You can select English, French or German for operating Clublink.

Þ From the Options menu on the Clublink Opening Screen select Language.
Þ Select a language.
Þ Click OK.

4.4 Tax System

The tax system is used to set the default tax for each financial edit box in Clublink.  Taxes can be individually
changed when required by double clicking the financial edit box and overriding the Tax System settings.

Þ From the Options menu on the Clublink Opening Screen select Tax System.
Þ Begin at the top left of the Tax System screen and enter the appropriate details.
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+Note+:  An example of a $100 purchase using the tax codes that you have selected is shown in the right side of
the Tax System window.

4.5 Member Reports - Waiver Forms

Use the Member Reports button  to select one report to be associated with each Role in Clublink and one
with Class Level.  If you have a membership waiver form, this can be assigned and printed for any member with
just one button click. We can make a custom waiver form for your club. Visit www.integratedsports.net for
samples and ordering information.

Þ Select Member Reports from the Options menu on the Opening screen.
Þ Select an appropriate report from each drop box for each Role and for Class level report.
Þ Click OK to save your changes.
To use the Member Reports, select a member in Member Level or Class Level and click the Member Report

button on the toolbar.  This will generate the report that has been linked to the current Role.

5 Day to Day Operations

See
Opening Screen
Clubs
Members

5.1 Opening Screen

The Clublink opening screen is your access to each of the three levels of Clublink – Classes, Members and Clubs.

Þ The Classes button gives you direct access to your schedules and the class information in those schedules.
Þ The Members button takes you directly to all of your member data for each of the five roles.
Þ The Clubs button allows you to view or edit your club information including mailing address, phone

numbers, your logo and other club details.

The opening screen also gives you access to a list of upcoming birthdays and a quick way to backup your data.
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See
Administrator Password
Read-Only Password
Language
Tax System
Member Reports – Waiver Forms
Receive Central Office Setup Disk
Import Club Data
Export Club Data

5.2 Clubs

Þ From the opening screen, click the Clubs button  to view or edit your club information.

Postal

Þ Click on the Postal tab to enter your club name, address, phone numbers.
+Note+: The club mailing address can be included on member invoices.
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Registration Status

Located on the Postal tab Registration Status will show you your current affiliation with your Central Office (or
governing body).  A green light indicates that your club registration with your Central Office is in good standing
and a red light indicates that you are not currently registered with your Central Office.  The Expiry lets you know
when your registration will expire.  Your registration status will automatically update when your Central Office
sends you confirmation of your registration.

Club Number

A number assigned to your club by your Central Office.

Next Card No.

Clublink generates membership card numbers automatically for new members. They are sequentially numbered
with additional information depending on your sport and location. Consult your Central Office for your
membership numbering method.

+Note+:  If you do not have a Central Office, you can ignore the Registration Status and Club Number section
of the Postal tab page.

Þ Click the Contact tab and enter the e-mail address, name and phone number for your club's primary contact
person.

Þ Click the General tab and enter any additional information that pertains to your club.
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Club Logo

Þ Save your club logo (bmp or jpeg file) to Clublink\Images folder.
Þ From the Opening Screen click the Clubs button.
Þ Select the Logo tab.

Þ Click the See File List button  at the bottom of the window.
Þ Select a file.

5.3 Members

The Members section of Clublink includes all your member data organized into five Roles.  The roles are pre-
defined as Recreational, Competitive, Coach, Judge and Member.  When you begin using Clublink, you will
either have Member data in your system (as described in Page 5 (data disks) of Setup Wizard) or you will need to
enter your current Member data.

See
View Order of Members
Active Members
Financial Mode
Registration Form

5.3.1 Viewing

Þ Click on the Members button  on the Opening Screen.
Þ In the top right corner of the screen, select the Role that you wish to view from the drop down list.  The

member list will appear on the left side of your screen.
Þ Click on the name of the member you want to view.  If you don't see the name on your screen, type the last

name in the Search box above the member list.
Þ Click on each of the seven Tabbed Pages to view all of the member's information.
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+Note+:  If you aren't sure which Role the member is in, you can click the Search All Roles button  on the
toolbar and type the last name of the member.  When you have found the right member, click Select to view that
member's details. If you think you may have lost a member, there are many other search options from the Search
All Roles button (ex. Phone number).

5.3.2 Active Members

When viewing the member list, you will notice green Ö or red C to the left of the member list.  These symbols
indicate whether or not the member is active in your club.

Þ To view Active Members Only click on the  on the toolbar.

Þ To switch back to viewing all members, click on the  again.

5.3.3 Financial Mode

You can also choose to view your members in Financial Mode.  This will allow you to see which members have
outstanding fees at a glance.

+Note+:  We recommend that you use Financial Mode only when it is necessary as it slows down the program
operation.

Þ From the Clublink Opening Screen choose the Options menu.
Þ Click Financial Mode.
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Þ Click the checkbox to turn Financial Mode on.
Þ Select which accounts you would like to recognize.
Þ Select where you would like to be able to see the financial indicator.
Þ Click OK.

When you view your Member List, Phone Lookup, or Class Lookup, you will see a   beside the members
who have outstanding account balances.

5.3.4 Registration Form

See
Adding Members
Editing Members

5.3.4.1 Adding Members

The Registration Form is a two-page form that includes the selected Data Fields (see Page 4 – Data Fields in
Setup Wizard).  It is used when adding a new member to your database and is also used to edit existing member
information.

+Note+:  You can also add new members directly from Class level.  See Classes/Adding Members.

Þ In the top right corner of the Member screen, select the Role that you want to add the member to. (ex.
competitive, recreational, coach, etc.)

Þ From the bottom of the Member screen click the Add button.
Þ Type the last name of the person you are adding in the search box to ensure they are not already in your

system.

+Note+:  You can choose not to search by clicking the Ignore button at the bottom of the search window if you
are certain the member does not already exist in the system.

Þ If you do not find the person click the Ignore button or if you find a family member of the person you are
adding, you can click Select and then choose No to indicate that you found a family member.  This will
allow you to enter the new member's information with much of it automatically filled in.

Þ Members should not exist in a role more than one time. If you found the member in the role where they are
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to be added, then Select the member and press No to Add Again.
Þ Fill in the first page of the Registration Form by typing in the necessary information (highlighted areas are

Required Information and should not be left blank).

Þ Click Next at the bottom right of the screen to proceed to the second page of the form and fill in the
remaining information.
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Þ Check the bottom left corner of the screen to ensure that you are adding the member to the correct Role.
This can also be used in the case that a member changes roles during the season.

Þ Click OK to close the form.
Þ You can choose to see the Member Worksheet  by clicking OK or click NO to skip.

5.3.4.2 Editing Members

Þ Click on the member you want to edit in the Member List or use the Search feature to find the member.
Þ Click the Modify button at the bottom of the screen.  Alternately, you can double click the member.
Þ The Registration Form will come up for you to edit the Member details.
Þ Click Next to make changes on the second page of the registration form.
Þ Click OK when you are finished making changes.
Þ You can choose to see the Member Worksheet by clicking OK or click NO to skip.

5.3.5 Member Maling Address

The member's mailing address  is often the same as the address entered on the General tabbed page. You
can specify an alternate mailing address for a member.
Ex: Change the name on the mailing address to mail invoices to the parent rather than the child.
Some reports use the information on the General tabbed page whereas some other reports will use the Mailing
Address. If you make a change to the member's address, you will be asked if you would like to update the mailing
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address too.
+Note+: Labels can be printed using either address. There is an Avery 5160, 5161 and 5162 reports setup for
mailing address.

6 Member Worksheet

The Member Worksheet  assesses the member's file to determine which automated actions (ex. charge
registration fees, assign a membership card, prepare member for export to central office, charge class fees) need
to be performed.

Þ Check the Active box to indicate a member is active. This should already be checked.
Þ Check the Registration box to add the member to the Registration Drop Button  and have them

prepared for export to the Central Office. Adding members to the Registration Drop Button is also a
handy way to know how many members you have registered during your session.

Þ Check the box for your Central Office Registration Fee (ex. Ontario Gymnastics Fee).  This fee is
defined in your Linked Registration Options (selected on the Registration Form) and is usually
assessed once per season.

+Note+:  If you do not have a Central Office, you don't need to check this box.

Þ Check the box for your Club Registration Fee if you have one.  This fee is defined in your Linked
Registration Options (selected on the Registration Form) and is usually assessed once per season.

Þ Check the Next Card Number box to have the next membership card created for this member.
Þ Click OK to save the changes and leave the Member Worksheet or Cancel to leave without applying

the changes.
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The Restore button a the bottom of the Member Worksheet can be used to restore the original selections in the
Member Worksheet and recalculate the Registration Fees.

The Uncheck All button will remove the checks from all boxes except the Active box.

+Note+:  When registering a member in the Member Level, class fees, pro-rated fees and discount options will
not be visible on the Member Worksheet.  These options are available when  you add a member to a specific
class. (see using the Member Worksheet in Class Level).

7 Fees

Fees can be viewed by clicking the Fees button on the toolbar.  You will also be prompted to view the Fees
for a member after closing the Member Worksheet.

There are three tabbed pages in the Fees section of Clublink.

Payments - includes a detailed list of all payments made to the club by the Member.

Summary - is a quick view of all three of the member's accounts.

Fee Assessments - is a list of all fees charged to the member with a record of what is due, what's been paid and
what the balance is for each assessment.
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7.1 Fee Assessments

Fees are assessed by member and may be viewed for an individual member or for the entire family by selecting
individual or family in the bottom right corner.

+Note+:  Family is defined as individuals with the same phone number.

See
Fees
Adding a Fee
Modifying a Fee
Deleting a Fee

7.1.1 Adding a Fee

Þ Click the Add button at the lower left of the screen.
Þ Click the drop down box at the bottom of the window to select the type of fee you want to add.  If the type

you want is not in your system yet, you can add it by typing the name of the fee in the details box.

+Note+: It is important to be consistent with fee naming to facilitate financial reporting.

Þ Enter the amount of the fee.
Þ Click OK to complete the fee assessment.

+Note+:  There is an on screen calculator for your convenience.

See
Fees
Fee Assessments
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7.1.2 Modifying a Fee

Þ Click on the fee you wish to modify.
Þ Click the Modify button at the lower left of the screen.
Þ Change the name and/or amount of the fee.
Þ Click OK.

See
Fees
Fee Assessments

7.1.3 Deleting a Fee

Þ Click on the fee you wish to delete.
Þ Click the Delete button in the lower part of the screen.
Þ Click OK to delete the fee assessment.

+Note+: It is a good idea to only delete fees that have been assessed in error or if the amount due is equal to the
amount paid. You can delete any fee but this can sometimes confuse the member on their invoice.

See
Fees
Fee Assessments

7.2 Payments

See
Fees
Applying a Payment
Modifying a Payment
Deleting a Payment

7.2.1 Applying a Payment

You can apply a payment to outstanding fees from the Fee Assessments tab, the Summary tab or the Payments
tab.

Þ Click on the Payments button  located near the upper right of the window.
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Þ Select the date of the payment (or the date of the first payment if you are entering multiple payments).
Þ Enter the Amount of the payment.  Enter the amount of the most common payment for multiple payments.
Þ Select the appropriate Payment Type from the drop box.
Þ If the payment type is a Credit Card, enter all requested details.
Þ For a single payment, click Next, click on the fee or fees the member is paying, then click the Apply button.

Click the OK button to save the changes.
For multiple payments, click Multiple Payments, enter the number of payments being made and click OK,
review the dates and amounts of the payments (you can edit the dates and the amounts as necessary by double
clicking on the list of payments shown in the top right corner of your screen), click OK, then apply each payment
to the corresponding fee by selecting the fee and then clicking Apply.  Click the OK button to save the changes.

See
Fees
Payments

7.2.2 Modifying a Payment

You can modify the date of a payment from the Payments tab in the Fees window.  You cannot modify a
payment that has been deposited.

Þ Click on the Payments tab in the Fees window.
Þ Select the payment you want to modify.
Þ Click Modify.
Þ Change the date of the payment.
Þ Click OK.

See
Fees
Payments
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7.2.3 Deleting a Payment

You can delete a payment from the Payments tab in the Fees window.  You cannot delete a payment that has
been deposited.

Þ Click on the Payments tab in the Fees window.
Þ Select the payment you want to delete.
Þ Click Delete.
Þ In the Details window ensure that you are deleting the correct payment.
Þ Click OK.  You will notice that the Balance in the bottom centre of your screen has changed to reflect the

deletion.

See
Fees
Payments

8 Accident Reports

Accident Reports are used to record the details of any accident or injury that may occur at your club.  Your
Central Office may have sent you a template for recording accident details (the template would have been
received on your Central Office Setup Disk).  If you do not have a template for your Accident Reports, you can
create one using the Medical Template feature (see creating a Medical Template).

8.1 Completing an Accident Report

Þ In Member level select the appropriate member from the member list.

Þ Click the Accident Report button .
Þ Click the Add button.
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Þ Enter a description of the accident in the Description box.
Þ Edit the date in the Date box if necessary.
Þ Press F3 on your keyboard to proceed to the first Data Entry Area (data entry areas are enclosed in <

>).
Þ Enter the appropriate information and press F3 again to proceed to the next Data Entry Area.
Þ Complete the form.
Þ To print the Accident Report, select Print from the File menu or click Close to close the report and

save your changes.
Þ Close the Accident Reports window.

+Note+:  When you are preparing your data to export to your Central Office, you will be given an option to
include Accident Reports.

See
Accident Reports

9 Classes

In Class Level you have the ability to create an unlimited number of schedules for all of your classes and
programs.  Within each schedule you can create classes, assign teachers and times, add members to each class
and setup class costs to automatically charge fees when a member is put into a class.  Class Level is accessed by
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clicking the Classes button  from the Opening Screen.

See
Creating a Schedule
Modifying a Schedule
Creating Classes
Copy/Paste a Class Structure
Moving a Class
Adding to a Class
Make-up Class
Searching all Schedules
Attendance

9.1 Creating a Schedule

Þ Use the scroll buttons in the top right of the Class Level screen to scroll right until you see a tab called
NEW OR from the Tools menu, select Schedules then select Add then click OK.

Þ On the tabbed page called Title enter the Schedule Name.  This name will appear on the tab for this
schedule and in the drop list of schedules.

Þ Use the Details boxes for a description of the schedule (ex. dates that the schedule is in effect, days the
classes are offered, location of the classes). The Details of the schedule name will be included on all Class
reports.

Þ In the Copy Frame drop box, you can select an existing schedule and copy it's frame (row headings, column
headings, class structures and fees) to create your new schedule.

Þ On the tabbed page called Size, enter the number of columns and rows you would like to use in your
sechedule.

+Note+: You can adjust the schedule size later if necessary.

Þ Click OK when you have completed the Title and Size tab pages.
Þ On the new schedule, double click on a column heading to name the column.  Enter the name of the column

in the Column Heading box (column headings are often the times the class is offered).  Repeat this step for
each column.
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Þ On the new schedule, double click on each row heading to name the row.  You will be given the option to
select from your employee list for your row headings.

+Note+:  You are not obligated to use employees or teachers for your row headings.  You may simply put any
heading you like in the Last Name box. Members marked as Employees on the Miscellaneous registration
tabbed page will appear in the Employee list.

See
Classes

9.2 Modifying a Schedule

Schedule Name

Þ To modify the name of a schedule, click the Tools menu, select schedule, then select modify.  Alternately,
double click the cell at the top left of the schedule.

Þ Edit the name of the schedule.
Þ Click OK.

Rows - Add, Modify, Delete

Þ From the Tools menu, select Rows.
Þ Select Add to add a row to your current schedule, then enter the Teacher(Row Name), click OK.
Þ Select Modify to change the name of an existing row.  Alternately, double click the yellow row heading.
Þ Select Delete to delete an existing row.

+Note+:  Deleting a row will delete all class data in that row.

Columns - Add, Modify, Delete

Þ From the Tools menu, select Column.
Þ Select Add to add a column to your current schedule, then enter the Column Name, click OK.
Þ Select Modify to change the name of an existing column.  Alternately, double click the yellow column
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heading.
Þ Select Delete to delete an existing column.

+Note+:  Deleting a column will delete all class data in that column.

Adjusting Column Width

Þ Put your cursor on the line between two column headings.
Þ When cursor changes to a double arrow, click and drag to desired width.

+Note+: Adjusting the column width is only temporary and is often used for preferred printing results.

See
Classes

9.3 Creating Classes

In the Class level you can add new classes, add members to those classes, code the classes for easy reference and
automatically charge fees to members registering in a class.

See
Classes
Adding a New Class
Modify a Class
Deleting a Class

9.3.1 Adding a New Class

Þ From the Schedule view, double click on the cell where you want to add a class.
Þ Click on the Advanced button in the bottom right of the open class screen.

Þ Enter a Class Description in the class description box.

+Note+: This description will appear in the cell on your schedule.

Þ You may Colour code the class by selecting a colour for the font and a colour for the background.
Þ Enter the maximum number of participants for the class.
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Þ Add the names of any Additional Teachers.
Þ Add the names of the prices you will be charging for the class and the amounts.
Þ Add pro-rated fees.

+Note+:  The pro-rated fee usually is the amount that will be discounted if a member is absent from one class or
registers late.

Þ Click OK to save your settings.

See
Classes
Creating Classes

9.3.2 Modifying a Class

Þ From the Schedule view, double click on the Class that you wish to modify.
Þ Click on the Advanced button in the bottom right of the class screen.
Þ Edit the class settings.
Þ Click OK to save the new settings.

See
Classes
Creating Classes

9.3.3 Deleting a Class

Þ Select the Class that you want to Delete.
Þ Press the Delete button on your keyboard.
Þ Click OK to confirm the delete.

See
Classes
Creating Classes

9.4 Copy/Paste a Class Structure

Copying and pasting a class structure will result in a new class with the exact settings of the class you copied
however, the new class will be empty (no members in it).

+Note+: You can copy a class structure from one schedule to another.

Þ To Copy a Class Structure, select the class you want to copy.

Þ Click on the Copy Class button on the Class level toolbar.
Þ Select the cell where you want the new class to be.

Þ Click on the Paste Class button on the Class level toolbar.

See
Classes
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9.5 Moving a Class

Þ Drag any class to a new location in the schedule. Drag a class onto an existing class to swap them.

See
Classes

9.6 Adding Members to a Class Method 1

It is best to add members to a class after you have used the Advanced button to adjust all the settings for the
class (particularly the prices for the class).

Þ Double click the Class that you will be adding the member to.
Þ Click the Add button.
Þ From the Search All Roles window, type the last name of the member you wish to add.  If you found the

member, select them and then click the Select button, then choose Yes.  If you are adding a new member to
the class, click Ignore.

Þ Update the member's information or add the new members information to both pages of the
Registration Form then Click OK.

Þ Click Yes when asked if you would like to see the Member Worksheet.
Þ On the Member Worksheet ensure that the Active box is checked, check the Registration box if this is a

new member of if you have updated any member information that should be passed on to your Central
Office. This box will be checked automatically if the member is not already on the Registration Drop Button.

Þ For a new member, the Registration boxes will be checked (ex. Central Office Fee)  For an existing
member, the Registration boxes will only be checked if the member has not yet been charged these fees for
the current season.
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Þ Select the appropriate Price to charge.

+Note+:  You can use the Fee Options section to charge monthly fees rather than a one time class fee (ex. a
member registers with your club for the entire season but pays their fees monthly).  See setting up Fee Options.

Þ If desired, check the Pro-rated box and enter a number for the number of pro-rated fees to be calculated.
(ex. a member is injured and will miss the first three classes of the session)

Þ If desired, check the Discount box and enter a discount amount as a percent of the total price (ex. the second
family member registered for the same class may receive a 10% discount).

+Note+: Discounts do not apply to Registration Fees.

Þ Click OK to save changes to the Member Worksheet.
Þ Click Yes  to view the Fees page or click No to go back to Class level. Normally we view the Fees page if

we have a payment ready to apply.

+Note+:  You can use the Restore button at bottom of the Member Worksheet to restore the original settings.
You can use the Uncheck All button to uncheck all the boxes on the Member Worksheet except the Active box.

9.7 Adding Members to a Class Method 2

Þ Open the Search All Roles window.
Þ Drag a member directly into an open class.

+Note+: You will not be prompted to see the Registration Form, Member Worksheet or Fees window. These
can be opened manually with their respective speed button.
+Note+: Dragging a member directly into a class will place the member in Pending Mode, to remind you that

you have not processed them yet. Pending mode can be turned on and off via the Pending  speed button.

See
Classes
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9.8 Moving a Member to a Different Class

Þ Open the Class the member is registered in.
Þ Open the Class the member is switching to.
Þ Drag and drop the member from the current class to the new class.
Þ Click OK to confirm the move.

+Note+:  If the new class has a different fee structure you will be notified. However, you will have to make any
necessary adjustments on the members Fee Assessments page in the Fees window  manually.(see Fee
Assessments).

See
Classes

9.9 Removing a Member from a Class

Þ Open the Class.
Þ Select the member.
Þ Click the Delete button at the bottom of the Class window.
Þ Make the necessary Delete from Class selections.

+Note+:  If you uncheck the Active box in the Delete from Class window, the member will become inactive.  If
the Remove from Registration Drop Button is checked, the member will be taken off the Registration Drop
Button.

See
Classes

9.10 Searching all Schedules

Þ From the View menu in Class level select Search.   Alternately click the Search All Schedules button 
on the toolbar.

Þ Type the last name of the member in the Search box.

+Note+:  You have the option to search the current schedule only by checking the This Schedule Only box.
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Þ Select a member to view the class information on the right side of the Search Results window.
Þ To open a particular class, click the Show Class button at the bottom of the Search Results window.

See
Classes

9.11 Member Status in a Class

You can change a members status in a class to Pending (ex. has signed up for the class but has not paid yet,
Wait List (ex. wants to register in the class but the class is full so they have to wait for someone to drop out), or
Trial Class (ex. will try the class once then the member or the teacher will decide about registering for the class).
The members status is shown by the indicator to the left of the Age column in the class list.

Þ To indicate Pending , Wait List  or Trial Class  status for a member in a class, select the
member, then select the appropriate status button from the Class level toolbar.

Þ To turn off a status indicator, select the member, and then select the appropriate status button from the Class
level toolbar.

See
Classes

9.12 Make-up Class

A member can be temporarily placed in another class for a Make-up Class and will automatically be removed
after the date specified.  You can also credit a member with a make-up class (for a missed class) using the Make-
up Class List.

Þ Open the class that the member is currently in.
Þ Open the class that the member will be doing his/her make-up in.
Þ Drag and drop the member from the current class to the make-up class.
Þ When prompted, click No to indicate that this move is for a make-up class only.
Þ In the Make-up Class window, set the date for the member to return to his/her regular class and set the date

for the member to leave the make-up class.  The member will be added to the Make-up Class List and
removed automatically.

+Note+:  If the date is unknown, check the None box.

Þ Click OK.
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See
Classes
Credit a Make-up
Modifying Return Dates
Restoring a Member

9.12.1 Credit a Make-up

Þ To credit a member with a Make-up Class when a member has missed a class, select the member in the
class.

Þ Click the Make-up Class List button .
Þ Set the date for the member to return to the original class.

+Note+:  If the date is unknown, check the None box.

Þ When the makeup class is determined, drag the member from the Make-up Class List into the make-up
class and schedule the return date.

See
Make-up Class

9.12.2 Modifying Return Dates

Þ From the View menu select Make-up Class List.
Þ Select the member you want to modify.
Þ Click Modify.
Þ Make necessary changes to dates.
Þ Click OK.

9.12.3 Restoring a Member

Þ From the View menu select Make-up Class List.
Þ Select the member.
Þ Click Resotre.

9.13 Attendance

Clublink has a built in Attendance Module as well as close to 100 attendance reports.

See
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Creating an Attendance Form
Completing an Attendance Form
Classes

9.13.1 Creating an Attendance Form

Þ Select the Class.

Þ Click the Attendance button  on the Class level toolbar.
Þ In the Attendance Advanced window, select the days of the week that the class runs.
Þ Select a Start Date and End Date.
Þ Click OK, then close the attendance form.

9.13.2 Completing an Attendance Form

Þ Select the Class.

Þ Click the Attendance button  on the Class level toolbar.
Þ In the Attendance window click to place an X in each cell corresponding to an absence. (ex. cells that are

empty indicate that the member attended the class that day, cells with an X indicate that the member was
absent)

10 Finances

See
Bank Statements and Deposits

10.1 Bank Statements and Deposits

Viewing and printing your bank statement before you go to the bank to make your deposit will help you to
organize your deposit.  You will be able to reconcile the transactions entered in Clublink with the payments you
will be depositing to ensure that nothing is missed.

Þ In Member Level select Bank Statement from the Finances menu.
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Þ Select your Deposit Date.
Þ Select Short for a bank statement that includes name, date, amount and payment type OR select Long for a

statement that also includes receipt number, credit card type, name on credit card, expiry date and credit card
number.

Þ Click the Generate button.
Þ Review the statement to ensure that it matches   for your deposit.  If it doesn't match, you can close the bank

statement and make the necessary adjustments in each member's Fees window and regenerate the bank
statement after your changes are complete.

+Note+:  You can not regenerate a bank statement that has been confirmed so it is a good idea to print the bank
statement or save it as a text or MS Excel file for future reference.  Use the File menu in your report preview
window to select save or print.  Daily Bank Statements can be recreated from the Financial Reports windows.

Þ When your bank statement matches your deposit, you can close the bank statement report preview window
and click Confirm in the bank statement window.

Þ Once you have Confirmed the bank statement, all transactions included in the statement will show as
Deposited in the Payments section of each members Fees window.

+Note+: This process cannot be reversed. If you are uncertain, be sure to backup your data before Confirming
your bank statement.

10.2 Financial Reports

Financial reports can be done to provide information on previous transactions (deposited) and future transactions
(not deposited).  You can choose the report output to show transactions listed by member (Transactions Only), by
Transaction Details (the breakdown of the payments ex. t-shirts, club fees, track suits) or Transactions with
Details (payments with the breakdown of where the money went).  Select a date range for your report and
whether you want minimum information (short) or maximum information (long).
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Þ In Member level select Financial Reports from the Finances menu.

Þ Select a Start Date and End Date for your report.
Þ In the Transactions section select either Deposited transactions or Not Deposited transactions for your

report.
Þ In the Report Type section choose Transactions Only for transactions listed by member.

+Note+: For Transactions Only you can select Short for a report that includes name, date and amount OR
select Long for a report that also includes payment type, receipt number, credit card type, name on credit card,
expiry date and credit card number.

Example (Long option):

OR select Transaction Details for transactions listed by type.

Example:
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Þ Click the Generate button to create the report.

+Note+:  Use the File menu to print the report or to save it as a text or Microsoft® Excel file.

10.3 Group Fees

You can view/assess and modify fees to members in a group using the Group Fees window.  Group Fees can be
assessed to a group using the Finance Drop Button or by selecting Group Fees from the Finances menu in
Member level.

See
Finances

10.3.1 Finance Menu

Þ Select Group Fees from the Finances menu.

Þ Drag and drop each member (for whom you would like to assess fees) from the Member List into the Group
Fees window.

Þ Select the Account you would like to charge the fees to.
Þ Use the drop box to select an existing Fee Assessment OR enter a new Fee Assessment in the Details box.
Þ Click Next.
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Þ Enter the amount of the fee.
Click Apply to All to apply the same fee amount to all members listed.  OR Click Apply to apply the amount to
the highlighted member.

See
Finances
Group Fees

10.3.2 Finance Drop Button

Þ Add the members to the Finance Drop Button  (see Drop Buttons)
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Þ In the Output Format section select Group Fees.
Þ Click Start.
Þ Select the Account you would like to charge the fees to. (see screen shots in the Group Fees from Finances

Menu section above.)
Þ Use the drop box to select an existing Fee Assessment OR enter a new Fee Assessment in the Details box.
Þ Click Next.
Þ Enter the amount of the fee.
Click Apply to All to apply the same fee amount to all members listed.  OR Click Apply to applythe amount to
the highlighted member.

See
Finances
Group Fees

10.4 Invoices

Invoices are a statement of account listing Fee Assessments with amounts due, amounts paid and a balance.  A
list of undeposited (post-dated) payments can also be included.  You can invoice individual members or families
from the Fees window OR you can use the Invoice Drop Button to invoice individuals or groups of members.

See
Finances
Fees Window
Invoice Window
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10.4.1 Fees Window

Þ Select the member from the member list in Member Level or from a Classes.

Þ Click the Fees  button on the toolbar.

Þ Click the Invoice button in the Fees window.
Þ Check the appropriate boxes in the Invoice window (see Invoice Window for descriptions of each

checkbox).
Þ Click OK to print the invoice.

+Note+: To E-mail the invoice, generate the invoice as a PDF file and attach it to an email.

See
Finances
Invoices

10.4.2 Invoice Drop Button

Þ Open the Invoice Drop Button Window  in Member level.
Þ Add the members that you want to invoice to the Invoice Drop Button. (see adding members to drop

buttons)
Þ Select Invoice in the Output Format section.
Þ Click Start.
Þ Check the appropriate boxes in the Invoice window. (see Invoice Window for descriptions of each

checkbox)
Þ Click OK to print the invoices.

See
Finances
Invoices

10.4.3 Invoice Window

Invoice accounts – select one, two or all three accounts to be included on the invoices.

Language – select a language for heading on the invoice.

Not Deposited Payments – shows a list of Payments that have not been deposited (ex. post-dated cheques)

Balance = 0 – only prints an invoice if the total balance due for the member or family is zero.

Outstanding Details Only – shows Fee Assessment Details for fee assessments with a non-zero balance only (ex.
if the amount due is equal to the amount paid, the details will not appear on the invoice)

Note – shows a special note on the bottom of the Invoice (ex. No practice Dec. 25th and 26th.)

Family Invoice – prints Fee Assessment Details and Payments for all family members on the same invoice.

Invoice Summary Only – displays a summary report of the invoices but does not print the actual invoices.

Current, Past 30, Past 60, Past 90 – shows the amount due for specified time periods.

Club Return Address – prints the club's return address in the top right of the invoice.
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Page Offset – allows you to shift the printing of the invoice down the page to accommodate your club letterhead
(every page offset is equal to one inch)

Payment Details (page 2) – shows details of when payments were made, how they were made and how the
payments were applied.

Print to PDF Document(s) – prepares invoices to print to a PDF file.

See
Finances
Invoices

11 Certifications

You can use the certifications window to track a member's certifications (ex. levels completed, dates completed).
You can have up to seven certification charts for each of the five roles.  Some of these charts may be locked by
your Central Office, the others are available for you to customize. Certifications can be viewed and updated from
Member Level or Class Level.

See
Updating Certifications
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Customizing Certification Charts

11.1 Updating Certifications

Þ Select the Member.

Þ Click the Certifications button  on the toolbar.
Þ From the drop box in the top left of the certifications window, select the chart you want to update.
Þ Update the dates and/or certificate numbers.
Þ If you have proof of the certification on file, click the circle at the bottom of the appropriate column to

change it to green to indicate proof on file.

Þ Close the window when complete.

See
Certifications

11.2 Customizing Certification Charts

Þ In Member Level select Certifications from the Setup menu.
Þ In the Certifications window, select the appropriate Role.
Þ Select a chart to customize from the right side of the window.
Þ In the upper left corner of the chart enter the name of the chart.
Þ Edit the column and row headings. (ex. change level 1, 2 and 3 to Beginner, Intermediate and Advanced)
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Þ Close the window to save your changes.

+Note+:  Row headings that are in grey can not be changed.

See
Certifications

12 Keywords

Keywords are an effective method of assigning attributes to a member.  Keywords assist you in reporting on
members and finding groups of members (ex. you can assign a keyword to all members who attended provincial
championships on a May 1/04).  You can recall the list and report on those members by dragging the keyword
onto any Drop Button (see Drop Button Lists).

12.1 Assigning Keywords - Individual Members

Þ Select the member in the Member List or in a Classes.

Þ Click the Keywords button  on the toolbar.

Þ Click the Complete Keyword List drop down list.

Þ Select a Keyword from the list, then click the red arrow  and click Add.
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OR if you want to use a new keyword
Þ Enter the Keyword in the enter a new keyword here box and click Add.

See
Keywords

12.2 Assigning Keywords - Group of Members

Þ Drag and drop all the members who need the keyword onto any Drop Button (see Drop Button Lists).

+Note+:  You can also assign a keyword to groups of members that already exist in Class level by right clicking
on a class, select add to drop button list, select a drop button, select the group you want to assign the keyword
to. Then proceed with the instructions below.

Þ From Member level open the appropriate Drop Button window.
Þ From the File menu select Assign a Keyword.

Þ Use the Drop Box to select a Keyword.
Þ Click OK to add the keyword to all members on the Drop Button.
OR
Þ Type the new keyword in the upper box.
Þ Click OK to add the keyword to all members on the Drop Button.

See
Keywords

12.3 Deleting Keywords

Þ Select the member in the Member List or in a Classes.

Þ Click the Keywords button   on the toolbar .
Þ Select the Keyword that you want to delete from the top drop box.
Þ Click Delete.
Þ Click OK to confirm the delete.

+Note+:  To delete a keyword from all members, select Keyword List from the Lists menu in Member Level.
Select the keyword you want to delete then click Delete then click OK to confirm.

See
Keywords
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12.4 Reporting with Keywords

Þ Select Keyword List from the Lists menu in Member Level.
Þ Select a Keyword.
Þ Drag and drop the Keyword on to the drop button you want to use for reporting.

+Note+:  All members who have been assigned this keyword will be added to the drop button list.

See
Keywords

13 Drop Button Lists

Drop Buttons are used to organize members for reporting purposes.  There are four Drop Buttons in the
Member level of Clublink.  Members can be individually dragged and dropped onto these buttons OR groups of
members can be put on the drop buttons for reporting.

Invoice Drop Button  used to create invoices to be viewed or printed.

Report Drop Button  this is a general button for reporting on any type of member data.

Registration Drop Button   used to prepare members for export to your central office.

Finance Drop Button  used for Group Fee assessments.

+Note+:  Each of the above Drop Buttons has a selection of System Reports that relate to the type of drop
button. (See Reporting)

See
Adding Members to Drop Buttons
Reporting

13.1 Adding Members to Drop Buttons

The following methods can be used to add members to any of the four drop buttons:

Þ Drag and drop Individual members from the Member level member list.
Þ Drag a Keyword from the Keyword List (from the Lists menu in Member level select Keyword List) to add

all members with the selected keyword.
Þ Drag a Linked Registration Option (from the Lists menu in Member level select

Linked Registration Options) to add all members with the selected Linked Registration Option.
Þ Drag a Custom Drop Box selection (from the Lists menu in Member level select Custom Drop Boxes) to

add all members with the selected Custom Drop Box item.
Þ Drag a Fee Assessment Detail (from the Lists menu in Member level select Fee Assessments List) to add all

members with the selected Fee Assessment Detail.
Þ Add a schedule, row, column or class (from Class level select the appropriate schedule, from the Tools

menu select Add to Drop Button, choose a drop button then select what you want added to the drop button).
Þ Use the File menu in the drop button window and make a selection from the list.
Use the Wizard button for an advanced selection of members to be added to the Drop Button.
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See
Drop Button Lists
Reporting

14 Reporting

Reporting is done from any of the four Drop Buttons in Member level and from the Reports menu in Class level.
There are ready to use System Reports as well as a large selection of Custom Reports available for you to register
in your system.

There are many ways to get members onto the drop buttons for reporting.
There is a tutorial installed in the How To section on the Opening Screen showing many of the methods to get
members onto the Drop Buttons.

The File menu in the Drop Button Window is a good place to start. Depending on which members you are
currently looking at in Clublink, will affect the menu option.
Ex: If you are looking at Active Only Recreational members, then select "Add all of this Role", then only active
recreational members will be added to the button.

Ex: Select all members all roles on one button, select a single role on another button, subtract the two lists and be
left with 4 of the 5 roles.

Þ    Drag n Drop a single member
Þ    Drag n Drop any Linked Registration Option
Þ    Drag n Drop any Custom Drop Box List
Þ    Drag n Drop any City
Þ    Drag n Drop any Fee Assessment

+Note+:  Any time the cursor turns into a Clublink, that item can be dragged onto a report button.
+Note+:  Drag any item into the open Drop Button window or directly onto the button

Though Clublink stores all information in uppercase, you may choose not to "Output Info Completely in
Uppercase" from the file menu in the Drop Button window. Clublink will convert all applicable information to
Title case.
Ex: MCDONALD --> McDonald

See
Drop Button Lists
Class Level Reporting
Schedule Statistics
Class Reports
Drop Button Reports
Registering Reports
Report Wizard

14.1 Class Level Reporting

In Class level you can choose to report on the statistics of a Schedule (summarizes information about each of the
classes in the schedule) or you can select various types of reports to report on a Class.

See
Drop Button Lists
Reporting
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14.2 Schedule Statistics

Þ Select the schedule you want to report on.
Þ From the Reports menu, select Statistics.

From the File menu you can choose to save or print the report.

See
Drop Button Lists
Reporting

14.3 Class Reports

Þ Select the Class you want to report on.
Þ From the Reports menu, select Reports.
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Þ Select the Report Format (system or custom).
Þ Select a Report from the drop box OR register a new report. (see Registering Reports)
Þ Select an Output Format.
Þ Click Start.

+Note+:  If you select Screen as your output format, you can print or save your report once you have viewed it
by selecting Print or Save As from the File menu.

See
Drop Button Lists
Reporting

14.4 Drop Button Reports

Þ Select a Drop Button to report from.
Þ Add members to the drop button. (See Adding Members to Drop Buttons)
Þ Select the Report Format. (system or custom)
Þ Select a Report from the drop box OR register a new report. (see Registering Reports)
Þ Select an Output Format.
Þ Click Start.

+Note+:  If you select Screen as your output format, you can print or save your report once you have viewed it
by selecting Print or Save As from the File menu.

See
Drop Button Lists
Reporting
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14.5 Registering Reports

Þ Open the appropriate Drop Button.
Þ From the Reports menu select Register.
Þ In the Registered Reports window click the Add button.

Þ Select a report from the list in the New Report window.
Þ Type a description of the report in the Description box.
Þ Click the Register button.
Þ Click OK.
Þ Close the New Report window or select another report to register.

+Note+:  You can also Modify report descriptions or Delete registered reports from the Registering Reports
window.

If you have downloaded the report from our website or received the report as an email attachment, save the report
to your desktop, then drag n drop the report from your desktop into the appropriate drop button window.

See
Drop Button Lists
Reporting

14.6 Report Wizard

The Report Wizard is a great way to select a group of members using the user-defined checkboxes, edit boxes
and dates and the built in checkboxes and dates.



Reporting 56

©2005 Integrated Sports Systems (ISS) Inc.

15 Mail Merge

You can use your Clublink data to create a mail merge document in Microsoft® Word.

See
Preparing your Clublink Data
Preparing your Microsoft Word Document

15.1 Preparing your Clublink Data

Þ In Member Level select one of the four Drop Buttons.
Þ Add all of the members that you would like included in the mail merge to the Drop Button list.
Þ From the File menu select Create Tempmain.dbf for Export.
Click Yes if you wish to view the folder containing the Tempmain.dbf file, otherwise, click NO.

See
Mail Merge
Preparing your Microsoft Word Document

15.2 Preparing your Microsoft Word Document

Þ Open Microsoft Word.

+Note+:  You can open an existing letter, create a new letter now or create the letter later.

Þ From the Tools menu select Mail Merge.
Þ In the Main Document section click Create.
Þ Select Form Letter.

+Note+:  You can select any of the mail merge types on the list however, the steps for creating the document may
differ slightly from the instructions below.

Þ Click Active Window if your form letter is in the active window, otherwise, click New Main Document.
Þ Click Get Data.
Þ Select Open Data Source.
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Þ Go to your Clublink\Athlete folder.
Þ In the Files of Type box select dBase (*.dbf).
Þ Select Tempmain.DBF from the list of files and click Open.
Þ Click Edit Main Document.
Þ On the Mail Merge toolbar click Insert Merge Fields.
Þ Select the appropriate merge fields and insert them into your main document where you want the data to

appear.
Þ When you have completed setting up the main document, click the Merge button on the Mail Merge toolbar

and make the appropriate selections.

See
Mail Merge
Preparing your Clublink Data

16 Periodic or Infrequent Activities

See
List Items
Custom Drop Box Lists
Linked Registration Options

16.1 List Items

The items that appear on the Keywords List, City List and Fee Assessments List can all be managed using the
following steps:

See
Adding
Modifying
Deleting

16.1.1 Adding

Þ From the Lists menu in Member level select the appropriate list.
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Click the Add button to add a new item to the list and type the new list name, then click OK.

See
List Items

16.1.2 Modifying

Þ From the Lists menu in Member level select the appropriate list.
Þ Select a list item and click the Modify button to edit the list item.

+Note+:  This will modify all instances of the list item in Clublink.

See
List Items

16.1.3 Deleting

Þ From the Lists menu in Member level select the appropriate list.
Þ Select a list item and click the Delete button to delete the list item.

+Note+:  This will delete all instances of the list item in Clublink.

See
List Items
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16.2 Custom Drop Box Lists

From the Custom Drop Boxes window, you can add, modify and delete items that will appear in your Custom
Drop Boxes for each role. (This can also be done from Setup Wizard.)

See
Adding
Modifying
Deleting

16.2.1 Adding

Þ From the Lists menu in Member level select Custom Drop Boxes.

Þ Select the appropriate Role.
Þ Select the appropriate Drop Box.
Þ Click the Add button.
Þ Type the name of the new list item in the Name box.
Þ Click OK.

See
Custom Drop Box Lists

16.2.2 Modifying

Þ From the Lists menu in Member level select Custom Drop Boxes.
Þ Select the appropriate Role.
Þ Select the appropriate Drop Box.
Þ Select the list item you want to change.
Þ Click the Modify button.
Þ Type the new name of the list item in the Name box.
Þ Click OK.

See
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Custom Drop Box Lists

16.2.3 Deleting

Þ From the Lists menu in Member level select Custom Drop Boxes.
Þ Select the appropriate Role.
Þ Select the appropriate Drop Box.
Þ Select the list item you want to delete.
Þ Click the Delete button.
Þ Click OK to confirm the delete.

See
Custom Drop Box Lists

16.3 Linked Registration Options

Understanding Linked Registration Options is probably the most complex aspect of Clublink.  This is only due to
the fact that sports organizations tend to have many categories for their members and many different fees
associated with the categories.  Below is an example of how Linked Registration Options can be used to register
your members each season.  (See the Setup Wizard section for a more detailed description of how Linked
Registration Options work.)

From the Linked Registration Options window you can add, modify or delete your club's registration fees.
(This can also be done using the Setup Wizard).  Your Central Office registration fees can be viewed from this
window but you can not make any changes to them. Registration fees that have been setup by your Central Office
appear in yellow.

See
Adding
Modifying
Deleting
Central Office Only

16.3.1 Adding

Þ From the Lists menu in Member level select Linked Registration Options.
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Þ Select the appropriate Role.
Þ Select Member level from the drop box below the Role drop box.
Þ Select the appropriate column (category or sub-category).
Þ Click the Add button.
Þ Type the Name of the fee, the Fee amount and Min. and Max. Ages in the boxes at the top of the window .
Þ Click OK.

See
Linked Registration Options

16.3.2 Modifying

Þ From the Lists menu in Member level select Linked Registration Options.
Þ Select the appropriate Role.
Þ Select Member level from the drop box below the Role drop box.
Þ Select the Registration Option that you want to change.
Þ Click the Modify button.
Þ Edit the Fee amount.
Þ Click OK to save your changes.

+Note+:  You can only modify the name of a Linked Registration Option if your club has set it up.  Any name set
up by your Central Office is locked.

See
Linked Registration Options

16.3.3 Deleting

Þ From the Lists menu in Member level select Linked Registration Options.
Þ Select the appropriate Role.
Þ Select Member level from the drop box below the Role drop box.
Þ Select the Registration Option that you want to delete.



Periodic or Infrequent Activities 62

©2005 Integrated Sports Systems (ISS) Inc.

Þ Click the Delete button.
Þ Click OK to confirm the delete.
Þ Click OK to delete all references.

See
Linked Registration Options

17 Setup Menu - Member Level

See
Data Field Options
Medical Template
Payment Types and Credit Card Types
Fee Options
Central Office Data Field Options

17.1 Data Field Options

Data field options can also be selected from the Setup Wizard however the method shown below allows you to
make data field changes without closing Clublink. Hiding unused Data Fields will help customize Clublink to
your specific club requirements, helping to streamline the registration process by only showing information that
your club requires.

Þ From the Setup menu in Member level select Data Field Options.

Þ From the drop box select the appropriate Role.
Þ Select the appropriate tabbed page.
Þ Make the necessary changes.
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Þ Close the Data Field Options window.

+Note+:  When you un-select a data field, the data is not lost, it's just not visible in Clublink.

See
Setup Menu - Member Level

17.2 Medical Template

The Medical Template is a tool used to create customized Accident Reports for your Club.  The Medical
Template will appear when you click the Accident Report button for any member.  If you have a Central Office,
you may already have received a template on your Central Office Setup Disk.

Creating a Medical Template

Þ From the Setup menu in Member level select Medical Template.
Þ Type a heading or title for your accident report in the Medical Template window.
Þ Type the first Required Information Title in the Medical Template window. (ex. Date of Accident)
Þ Add a Data Entry Area beside the Required Information Title.

+Note+: Data Entry Areas need to be enclosed by Lesser Than and Greater Than symbols. (ex. <enter date here>
)

Þ Continue typing all of your Required Information Titles followed by Data Entry Areas on each line of the
template.

+Note+:  You can insert a page break by clicking the Page Break button at the bottom of the template window.

Þ Click OK to save your changes.

+Note+:  The user will be able to automatically proceed through the data entry areas by using the F3 key on their
keyboard.

See
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Setup Menu - Member Level

17.3 Payment Types and Credit Card Types

Payment types and credit card types are selections used when receiving payments form your members.  These
selections can also be set up using the Setup Wizard.

See
Setup Menu - Member Level
Adding
Modifying
Deleting

17.3.1 Adding

Þ From the Setup menu in Member level select Payment Types or Credit Card Types.

Þ Click the Add button.
Þ Type the name in the Title box.

+Note+:  When entering a new payment type, check the credit card box if the payment type is a credit card.

Þ Click OK.

See
Payment Types and Credit Card Types
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17.3.2 Modifying

Þ From the Setup menu in Member level select Payment Types or Credit Card Types.
Þ Select a list item to Modify.
Þ Click the Modify button.
Þ Type the new name in the Title box.
Þ Click OK.

See
Payment Types and Credit Card Types

17.3.3 Deleting

Þ From the Setup menu in Member level select Payment Types or Credit Card Types.
Þ Select a list item to Delete.
Þ Click the Delete button.
Þ Click OK.

See
Payment Types and Credit Card Types

17.4 Fee Options

Fee Options is a method of pre-defining fee assessments to be assessed in Class level.  (ex. Many clubs register
their members for the year but charge fees on a monthly basis.  In this case, the months of the year should be used
for Fee Options.)  You will have the opportunity to select the appropriate Fee Options on the
Member Worksheet in Class level.

See
Setup Menu - Member Level
Adding
Modifying
Deleting

17.4.1 Adding

Þ From the Setup menu in Member level select Fee Options.
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Þ In the Fee Options window click Add.
Þ Type the new Fee Option in the Title box.
Þ Click OK.

See
Fee Options

17.4.2 Modifying

Þ From the Setup menu in Member level select Fee Options.
Þ In the Fee Options window select the Fee Option you want to change.
Þ Click Modify.
Þ Type the new Fee Option in the Title box.
Þ Click OK.

See
Fee Options

17.4.3 Deleting

Þ From the Setup menu in Member level select Fee Options.
Þ In the Fee Options window select the Fee Option you want to Delete.
Þ Click Delete.
Þ Click OK to confirm Delete.

See
Fee Options
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17.5 Central Office Data Field Options

Central Office Data Field Options allows you to view which fields are Required by your central office and
which fields are Requested.

Þ From the Setup menu in Member level select Central Office Data Field Options.
Þ Select the Role you want to view.
Þ Select Requested or Required from the top right of the screen.
Click through the tabbed pages to view the data fields.

See
Setup Menu - Member Level

18 Saving Schedules in Other Formats

From the Tools menu in Class level you can save a schedule as an Excel file or as a Web page.  You can also
build a web site using selected schedules. (See Task Manager)

See
Microsoft Excel
HTML Web Page
Home Page Generator

18.1 Microsoft Excel

Þ In Class level select a schedule.
Þ From the Tools menu in Class level select save schedule to excel.
Þ Select Yes to have the class volumes (number of members registered in class) show in excel or select No if

you don't want the class volumes.
Þ Select the folder that you would like to save the file in.
Þ Name the file.
Þ Click Save.
Þ Click OK.

See
Saving Schedules in Other Formats

18.2 HTML Web Page

Þ Select a schedule.
Þ From the Tools menu in Class level select Web site (html).
Þ Select save this schedule as a web page OR select save this schedule and all classes as a web page.
Þ Select the folder that you would like to save the file in.
Þ Name the file.
Þ Click Save.
Þ Click OK to see the Web page now or click Cancel.
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See
Saving Schedules in Other Formats

19 Central Office Communication

See
Receive Central Office Setup Disk
Import Club Data
Export Club Data

19.1 Receive Central Office Setup Disk

When you first begin using Clublink, your Central Office will send you a setup disk.  This disk contains
important information that sets up Clublink on your computer to work smoothly with your Central Office.

This disk will update Clublink with:

Ö Required Data Field Options (yellow boxes on member Registration Forms).
Ö Requested Data Field Options.
Ö Linked Registration Options for the current season.
Ö Registration Fees for the current season.

This disk may update Clublink with:



Clublink69

©2005 Integrated Sports Systems (ISS) Inc.

Ö Central Office Certification charts.
Ö A Medical Template (used for accident reports).

Þ In the Opening Screen select Receive Central Office Setup Disk from the Options menu.

Þ In the Create/Accept Files window, select the location of the setup files.
Þ Click OK.
Þ When the operation is successful, close the Accept/Create Files window.

+Note+:  Receiving Central Office Setup Disk can also be performed from the Setup Wizard.

See
Central Office Communication

19.1.1 Fixing Members Entered Early

Þ Install the Central Office Setup Disk.

Þ In Member Level access the Registration Form  for each member.
Þ Make the correct selections from the Linked Registration Options drop boxes.
Þ Click OK to show the Member Worksheet.
Þ Click Restore on the Member Worksheet to restore the not assessed registration fees.
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Þ Click OK to assess the new Registration Fees and Membership Card.

See
Central Office Communication
Receive Central Office Setup Disk

19.1.2 Fixing Members Entered with Wrong Disk

Þ Install the Central Office Setup Disk.

Þ In Member Level access the Fees window  for each member and delete the registration fee from the Fee
Assessment Details page. (See Deleting Fee Assessments)

Þ Access the Registration Form for each member.
Þ Make the correct selections from the Linked Registration Options drop boxes.
Þ Click OK to show the Member Worksheet.
Þ Click Restore from the Member Worksheet to restore the not assessed registration fees.
Þ Click OK to assess the new Registration Fees and Membership Card.

See
Central Office Communication
Receive Central Office Setup Disk
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19.2 Import Club Data from Your Central Office

Importing Club Data will update your Clublink system with Central Office required information and adds new
members to your system who have been added by your Central Office.  A list of changes will be created for your
verification.

Importing Central Office Data will:

Ö Update member information with current Central Office member information.
Ö Update registration status of members.
Ö Update the Club mailing information.
Ö Copy all imported members onto the Registration Drop Button List.

To Import Your Data

Þ On the Opening screen select Import Club Data from the Options menu.

Þ From the Import Options window select the location of the import file.

+Note+:  If you have selected the *.cle option, you must click the Open File button  and select the appropriate
file from the Open window.

Þ Click OK.
Þ The Error Report is automatically opened.  Review the Error Report (you can print it by selecting print

from the file menu) then close the Error Report.
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Þ In the Import Club Data window, click Show to view the Verification window.
Þ In the Verification window, you may choose to view the details of the members that you are importing by

selecting On from the Details menu.
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Þ Highlight each member in the Import Data list to see what Update will take place for each member (the
type of Update Action is displayed between the Import Data list and the Clublink list)

+Note+: This is an optional step.  You do not have to view the changes before completing the Import.

Þ If you would like to override the Action that will be performed on a member, click the Change button and
select the desired Action for that member.

Þ Click the Close button after you have made any necessary changes in the Verification window.
Þ In the Import Club Data window, click the Update button to update your Clublink data.
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Þ You may print the list of Import Changes for your files by selecting Print from the File menu in the Import
Changes window.

See
Central Office Communication

19.3 Export Club Data to Your Central Office

Exporting club data to your Central Office will update your central office with new members and changes to
existing members' information.  This process sends the required and requested information of all members who
are on the Registration Drop Button to the central office.  Once the export is complete, Clublink changes all
new members (on the Registration Drop Button) to Pending (have a yellow light on the Registration Tab page in
Member Level) until a confirmation file is sent by central office and imported to your Clublink (see Importing
Club Data from Your Central Office).  You also have the option to export certifications and accident reports.

See
Central Office Communication
Exporting Club Data
Export Wizard Options
Drop Button Lists

19.3.1 Exporting Club Data

Þ From the Options menu on the Opening Screen select Export Club Data.
Þ In the Wizard screen select the appropriate data options for export.

See
Central Office Communication



Clublink75

©2005 Integrated Sports Systems (ISS) Inc.

Exporting Club Data

19.3.2 Export Wizard Options

Not Registered – shows you the number of members in your system that are not registered and should be
exported to your Central Office.

Pending – shows you the number of pending members in your system.  This box should only be checked if you
wish to re-send the pending members information to your Central Office.  If you do not wish to re-send and are
just awaiting registration confirmation for them, leave the box unchecked.

Registered – This box shows you how many members are already registered, and there is no need to send them to
your Central Office unless requested.

Modified/New – shows you which members have been added to Clublink or which members have had their
required information changed since registration. It is recommended that you include these members with your
registration. This option only applies to the Clublink On-Line Registration module.

Remove from the Registration Drop Button List – shows you how many members are on the Registration Drop
Button List.  Check this box to remove the members from the drop button and only add the members you have
selected above (i.e. not registered, pending, registered).

Þ Click OK when you have finished your selections in the export wizard.
Þ In the Export Club Data window, click each Show button to view any of the export information.

+Note+:  You will not be able to create your export files until you have viewed the Error Report.  You may also
Print the Error Report and the Statement by selecting Print from the File menu when viewing each report.  The
Statement is an estimate of your registration fees. Your Central Office will determine the exact amount due.
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Þ Check the Certifications box if you wish to update your members certifications with your Central Office. If
this box is unchecked, then your Central Office does not require your Certifications.

Þ Check the Accident Reports box if you wish to update your accident reports with your Central Office.  If
this box is unchecked, then your Central Office does not require your Accident Reports.

Þ Enter the amount of your Club Fee if you are paying a Club Fee to your Central Office at this time.
Þ Click the Create Files button once you have completed the Exporting Club Data window.
Þ In the Export Methods window, select the method you wish to use to send your Export Files then click the

large rectangular button in the grey box (the details of this button will change according to your export
method selection).

+Note+:  If you prefer a different export method, select the option to "Open the folder containing your export
files".  From the explorer window, select the current export file and copy it to the desired location (i.e. a floppy
disk or an email other than Microsoft Outlook).
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Þ Close the Export Club Data window.
Þ Select the appropriate option in the Confirm window.

See
Central Office Communication
Exporting Club Data

20 New Season

New Season is a very important feature of Clublink and should be performed at the start of each registration
year.  Performing New Season will reset many aspects of Clublink to be ready for a New Season.  Failure to run
New Season could result in incorrect fee assessments and inaccurate recording of Active members.

See
When to Perform a New Season
What you Need to Perform a New Season
Early Registration
Performing New Season
New Season Options Descriptions

20.1 When to Perform a New Season

Perform a New Season close to the expiry date of membership cards  before entering members for the upcoming
registration season.  (If you would like to enter members for the upcoming season before you have received the
new Central Office Setup Disk, see Early Registration)

+Note+: The system will change the registration status of members from Registered to Not Registered when
their expiry date has been surpassed, but it is better to do it manually via New Season.

See
New Season
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20.2 What you Need to Perform a New Season

1. The Central Office Setup Disk for the upcoming registration season.
2. Create a backup disk of Clublink via Clublink – Utilities and store it in a safe place away from your hard

drive.
3. Make note of any Linked Registration Options you have created for your club. If you have created Linked

Registration Options, they are linked to the Central Office Linked Registration Options and may
disappear if your Central Office makes changes (this can be easily seen in the Setup Wizard). Review any
changes made to the Linked Registration Options before accepting your Central Office Setup Disk for
the new registration season.

See
New Season

20.3 Early Registration

If you would like to perform early registration (entering members before you have received the new Central
Office Setup Disk), we suggest the following method:

1. Assign a keyword to the new member (see Assigning Keywords).
2. Do not access the Member Worksheet when registering the member.
3. Do not make any Linked Registration Option selections when registering the member.

When the new Central Office Setup Disk is received,

1. Perform New Season. (See Performing a New Season)
2. Install the Central Office Setup Disk into the system. (See Receiving Central Office Setup Disk)
3. Place all early registration members onto a Drop Button by dragging the keyword from the Keyword List

onto one of the four Drop Buttons.
4. Access the Registration Form for each member on the Drop Button.
5. Make the correct selections from the Linked Registration Options.
6. Press OK and show the Member Worksheet.
7. Press Restore from the Member Worksheet to restore the not assessed Registration Fees.
8. Assess the new Registration Fees and Membership Card.

See
New Season

20.4 Performing New Season

Þ On the Opening screen select New Season from the Options menu.
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Þ Select the items you want completed for your new season. (see description of New Season items below)
Þ Select which members you want to perform New Season on.
Þ When prompted to set next card number to 1 choose Yes to do it now.

See
New Season

20.4.1 New Season Options Descriptions

Set all members to not Active – will change all members from a green check mark to a red 'X'. Instead of deleting
members at the start of each season, make them Not Active. To activate a member that returns for the new
registration season, follow the instructions for Adding a New Member and select the correct member from the
Search All Roles list.

Assign a keyword to all Active members… – will enable you to recall all members from a season and perform
statistical analysis.

Set all members to Not Affiliated – will change all affiliation status lights from Green or Yellow to Red and clear
the expiry date.

Delete all paid transactions – will erase all transactions where the amount due is exactly equal to the amount
paid. This process will remove unwanted financial information for the New Season and can be run throughout
the season (see example).

Delete deposited receipts before… – a given date will remove all transactions that have been acknowledged as
deposited (have a deposit date) before a specified date. Deleting deposited receipts will enhance the performance
of Clublink and remove unwanted receipts. Set a deletion date to a reasonable date where you would not have to
justify a payment and it's details. Keeping receipts in Clublink for one year is reasonable provided you perform
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annual backups of your software.

Rename transaction details… – will rename fee descriptions by adding in the year of the fee to differentiate old
fee descriptions from current fees.

See
New Season

21 Task Manager

Task Manager can be accessed from Clublink Application Launcher.  Task manager allows you to perform
tasks that are not included in Clublink.  If there is something you would like to see added to Task Manager,
please contact us with your suggestion or request.  Once the task manager methods are tested and approved, they
will be incorporated into future releases of Clublink.

See
Fee Replicator
History Query
Export Data to the Web
Import Data from the Web
Home Page Generator
Email List Maker

21.1 Fee Replicator

The Fee Replicator is a tool used for recurring fees (ex: monthly membership fees).  This option is particularly
useful when you want to charge new fees to everyone on a particular schedule without entering them into new
classes on a new schedule.
Þ Make sure you have the appropriate members on one of the Drop Buttons in Member level. (See adding

members to a Drop Button)
Þ Select Fee Replicator from the Task Manager list.
Þ Click Launch at the bottom of the Task Manager window.
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Þ Select the appropriate Drop Button List.
Þ Select the From Fee and To Fee. (ex.  From January, To February)
Þ Click Next.
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Þ To replicate the original fees for all members click Replicate All OR to apply different amounts, use the
Custom Fees selections.

+Note+:  You can save this report by clicking Save As.

Þ Click Next when you are finished in the Fee Replicator window.
Click OK to confirm.

See
Task Manager

21.2 History Query

Using the History Query you can create a report based on History information.  History information is found on
the History tab page of each member in Member level. (ex. who changed levels between Sep 1/03 and June
30/04)

Þ Make sure you have the appropriate members on one of the Drop Buttons in Member level. (See adding
members to a Drop Button)

Þ Select History Query from the Task Manager list.
Þ Click Launch at the bottom of the Task Manager window.

Þ Select the appropriate Drop Button List.
Þ Select a History description to report on.
Þ Select the appropriate date parameters.
Þ Click Next.
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Þ After viewing the report you can choose to save it by clicking the Save As button.

See
Task Manager

21.3 Export Data to the Web

The Export Data to the Web feature allows you to send your Membership information to the internet to be picked
up by your Central Office.  This method eliminates the need to send in your data on a floppy or attach it to an
email.  You can also store your Clublink Backup data directly on the internet.  Only you can access the data.

Þ Select Export Data to the Web from the Task Manager list.
Þ Click Launch at the bottom of the Task Manager window.
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Þ Select either Membership Data or Clublink Backup.
Þ Select the export file from the File List.
Þ Click the Export to the Web button.
Þ In the Task Manager window click OK to confirm via the web.
Þ From the Upload Clublink Information window follow the on screen instructions.

See
Task Manager

21.4 Import Data from the Web

The Import Data from the Web feature allows you to download Membership information from the internet that
was placed there by your Central Office.  This method eliminates the need for your Central Office to mail you a
floppy or email you attachments.  You can also download your Clublink Backup that you have stored on the web.

Þ Select Import Data from the Web from the Task Manager list.
Þ Click Launch at the bottom of the Task Manager window.
Þ Select either Membership Data or Clublink Backup.
Þ Click the Import from the Web button.
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Þ When the import is complete, close the Import Data window.
Þ To update your Clublink with these files, see Importing Club Data or Restoring Data Files (if you

imported Clublink backup files).

See
Task Manager

21.5 Home Page Generator

Home Page Generator makes it easy for you to create a web page of your Schedules and Classes.

Þ In the Class level of Clublink select the schedule you want for your web page.
Þ From the Tools menu select Web site html, then select either save this schedule as a web page or save this

schedule and all classes as a web page.
Þ Repeat the saving process for each schedule that you want for your web page.
Þ Select Home Page Generator in Task Manager and click Launch.
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Þ Select each file you want to include then click the Add button  to add the file to the list of Output Files.
Þ Click Generate to create the web pages.
Þ Click OK to preview the web pages.  This selection will also provide you with the location of the saved web

pages to send to your web master.

See
Task Manager

21.6 Email List Maker

You can generate a list of emails to be copied into your email program.  This is a handy tool for sending group
emails to your members.

Þ Make sure you have the appropriate members on one of the Drop Buttons in Member level. (See adding
members to a Drop Button)

Þ Select Email List Maker from the Task Manager list.
Þ Click Launch at the bottom of the Task Manager window.
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Þ Select the appropriate Drop Button List.
Þ Click the Generate Email List and put it on the Clipboard button.
Þ Click OK in the Clublink Task window.

+Note+:  A list of members from the drop button you selected that do not have email addresses will be produced.

Þ Open your email program.
Þ Create a new email or open an existing email that you wish to send.
Þ Place your cursor in the Email Recipient box (or TO: box).
Þ Press Ctrl+V (hold down the Ctrl key and press V at the same time) on your keyboard to paste the email

addresses into the recipient box.
Þ Proceed with your usual steps for sending an email.
Close the Email List Maker.

See
Task Manager

22 Chit System

The Clublink Chit System does not come with the standard installation of Clublink but may be downloaded from
the web site.

The Clublink Chit System is a fast method of assessing fees to your members.  You can use the Chit System
while Clublink is closed or open.  The Master Details list allows you to categorize your fee assessments for easier
reporting and assign default fees to further expedite the fee assessment process.

The first time you open Chit System you will be prompted to setup your Master Details.  You can also edit this
list at anytime.
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See
Setting Up Master Details
Entering Fee Assessments

22.1 Setting Up Master Details

Þ From Clublink Application Launcher click Chit System.

Þ If Master Details does not open immediately, click the Fees List button  on the toolbar or select
Manage Master Detail List from the File menu.

Þ Select each Fee Assessment and then click Edit to add a Master Detail.
Þ In the Pricing section enter a default amount and an alternate amount if desired.
Þ Click OK to save your changes.

See
Chit System

22.2 Entering Fee Assessments

Þ From Clublink Application Launcher click Chit System.
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Þ Find the member by entering their Membership # or by typing their Last Name.
Þ Enter the date.
Þ Select a Fee Assessment from the list.
Þ Select the Default Price or the Secondary Price.
Þ Click Apply to apply the Fee Assessment.

You can add another Fee Assessment or click the Apply All Amounts button  located above the History
section.

See
Chit System

23 Utilities

Clublink Utilities is designed for easy management of your Clublink database.  To Open Clublink Utilities select
it from the Clublink Application Launcher.

+Note+:  To use Clublink Utilities you must close Clublink.

See
Clean-up and Rebuild
Rebuild Class Lists
Delete Data
Backup Data Files
Restore Data Files

23.1 Clean-up and Rebuild

Clean-up and rebuild reduces the hard disk space necessary to run Clublink and speeds up the operation of the
program.

Clean-up and Rebuild should be completed:
Ö When you open Clublink and it prompts you that Clean-up is overdue.
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Ö When Clublink is Unable to open all data files.
Ö When information does not appear properly in Clublink.
Ö When regular maintenance is being performed on you computer. (ex. Scandisk, Defrag, etc.)

Þ Select Clean-up and Rebuild from the Clublink Utilities screen.
Þ When the process is complete, click OK.

See
Utilities

23.2 Rebuild Class Lists

Rebuild Class Lists should be run if Class Volumes in Class level are showing incorrect numbers.  This process
will correct the Class Volumes.

Þ Select Rebuild Class Lists from the Clublink Utilities screen.
Þ When the process is complete, click OK.

See
Utilities

23.3 Delete Data

Delete Data is used to delete large amounts of data from Clublink.  The Delete Data function should be used with
caution as there is no undo button.  Always back-up your data before using the Delete Data function (see Back-up
Data Files).

Þ Select Delete Data from the Clublink Utilities screen.
Þ Select the data you want deleted.
Þ Click OK.
Þ Click Yes to confirm deletion or click cancel to abort the process.

See
Utilities

23.4 Backup Data Files

Use the Backup Data Files to backup your data on a regular basis.  This feature compresses all Clublink data and
saves it to a single file.

Þ Select Backup Data Files from the Clublink Utilities screen.
Þ Click OK to begin the backup.
Þ Choose the destination location and file name.
Þ When the process is complete, click OK.

See
Utilities

23.5 Restore Data Files

Use the Restore Data Files feature to use the data from your backup file to overwrite your existing Clublink data.
You can choose to restore from any backup file created with the same version of Clublink.
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Þ Select Restore Data Files from the Clublink Utilities screen.
Þ Choose the backup file to restore (*.clb).
Þ Click OK at the warning window OR click cancel to abort.
Þ Type the word Replace in the Confirm Restore window.
Þ Click OK.
Þ In the Restore Data Files window, check the directory and filename that you will be restoring from and

click OK to confirm or cancel to abort the process.
Þ When the process is complete, click OK.

See
Utilities

24 Central Office Only

See
Creating a Central Office Setup Disk

Required and Requested Information
Linked Registration Options
Custom Drop Boxes
Certifications
Medical Template
Last Revision Date
Central Office Letter
Registration Year
Membership Card

Distributing Central Office Setup Disk
Club Information Management
Importing Data from a Club
Exporting Data/Confirmation to a Club
Fees

Charging Fees to a Club
Invoicing a Club
Receiving Payments from a Club

New Season
Performing Central Office New Season
New Season Option Descriptions

24.1 Creating a Central Office Setup Disk

The Central Office Setup Disk allows you to define what information will be required and requested from each
of your clubs.  It also allows you to set the Linked Registration Options (Registration fees and categories) for
your clubs.  You need to create a Central Office Setup disk prior to the start of each registration season or
whenever a change is made to the registration criteria (i.e. fee change, you require additional information, etc.)
This disk should be distributed to all clubs well in advance of their registration to ensure they are collecting the
appropriate fees and information for each member.  When distributing the Central Office Setup Disk you should
create a document describing your Linked Registration Options, required and requested information and your
fee structure.  Special notes should be made to detail any changes to the system from one season to the next.

Þ Select Build Central Office Setup Disk from the Central Office menu on the Opening screen.
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See
Central Office Only
Creating a Central Office Setup Disk

Required and Requested Information
Linked Registration Options
Custom Drop Boxes
Certifications
Medical Template
Last Revision Date
Central Office Letter
Registration Year
Membership Card

Distributing Central Office Setup Disk

24.1.1 Required and Requested Information

Þ In the Build Central Office Setup Disk window, click Show and tab through each page of data fields
making the Required Information selections (If a club omits required information, they will receive an
error message when entering members into Clublink).

+Note+:  You must select which information is required for each Role separately by selecting the Role from the
drop box at the top of the Data Field Options window.  (See instructions on setting up the Certifications
template)
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Þ Click Close when you have completed your Required Information selections.
Þ In the Build Central Office Setup Disk window, click Show and tab through each page of data fields

making the Requested Information selections.
Þ Click Close when you have completed your Requested Information selections.

See
Central Office Only
Creating a Central Office Setup Disk

24.1.2 Linked Registration Options

Linked Registration Options gives the Central Office the opportunity to create categories for your members,
assign fees to those categories and assign minimum and maximum age requirements for those categories.  Each
role can have categories (linked list #1), sub categories (linked list #2) and sub sub categories (linked list #3).

+IMPORTANT NOTE+:  Each selection in Linked List #2 and #3 will be dependant on the selection in Linked
List #1.  The first non-zero fee in the Linked List selection furthest to the right (deepest in the tree) will be
used for the Member.

Þ In the Build Central Office Setup Disk window, click Show to setup or change your Linked Registration
Options.

+Note+:  You must setup Linked Registration Options for each Role separately by selecting the Role from the
drop box at the top of the window.  You may not set any Linked Registration Options in categories or sub-
categories that have not been selected as Required Information in Central Office level.



Central Office Only 94

©2005 Integrated Sports Systems (ISS) Inc.

Þ Select the appropriate Role.
Þ Use the Add, Modify and Delete buttons at the bottom of the Linked Registration Options window to edit

your Linked Registration Options and Fees.

See
Central Office Only
Creating a Central Office Setup Disk

24.1.3 Custom Drop Boxes

There are two Custom Drop Boxes available on the General tab page in Member Level.  We recommend that,
where possible, you do not use these as Required Information for the Central Office.  These two drop boxes are
a valuable tool for clubs to customize.  If you do use the Custom Drop Boxes as Required Information, the
box will be highlighted in yellow for all clubs.  You will only be able to add to or edit the Custom Drop Boxes
in the Build Central Office Setup Disk window if they are selected as Required Information, otherwise you
may edit this list from Member level if it is not Required Information and therefore used by the Central Office
only.

Þ In the Build Central Office Setup Disk window, click Show to setup the Custom Drop Boxes.
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Þ Select a Role.
Þ Select a Custom Drop Box.
Þ Use the Add, Modify and Delete buttons at the bottom of the Custom Drop Boxes window to change your

drop box selections.

See
Central Office Only
Creating a Central Office Setup Disk

24.1.4 Certifications

Up to seven Certification templates can be created for each Role and can be locked by the Central Office so that
clubs can track the certifications of their members.  If a certification template is left unlocked on the Central
Office Setup Disk each club will have the opportunity to setup and track their own certification details.

Þ Click Show to view or edit the Certifications template.
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Þ In the Certifications window, select the appropriate Role.
Þ Select a chart to customize from the right side of the window (numbers 1-7).
Þ In the upper left corner of the chart enter the title of the chart.
Þ Edit the column and row headings. (ex. row headings could be Start Date, End Date and Exam Date with

column headings of Level 1, Level 2, Level 3, etc.)
Þ Close the window to save your changes.
+Note+:  In the Build Central Office Setup Disk window, you must check the Certification box if you wish to
have the templates included on the disk.

See
Central Office Only
Creating a Central Office Setup Disk

24.1.5 Medical Template

The Medical Template is a form to be used by your clubs when reporting on accidents.  You may want to review
your insurance claim forms before creating the Medical Template to ensure the clubs are collecting all of the
necessary information.  If you do not choose to create a template, clubs will have the opportunity to create their
own.  You must check the Medical Template box on the Build Central Office Setup Disk window to include
the template on the disk.

Þ Click Show to view or edit the Medical Template.
Þ Type a heading or title for your accident report in the Medical Template window.
Þ Type the first Required Information Title in the Medical Template window. (ex. Date of Accident)
Þ Add a Data Entry Area beside the Required Information Title.

+Note+: Data Entry Areas need to be enclosed by Lesser Than and Greater Than symbols. (ex. <enter date here>
)

Þ Continue typing all of your Required Information Titles followed by a Data Entry Areas on each line of the
template.
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+Note+:  You can insert a page break by clicking the Page Break button at the bottom of the template window.

Þ Click OK to save your changes.

+Note+:  The user will be able to automatically proceed through the data entry areas by using the F3 key on their
keyboard.

See
Central Office Only
Creating a Central Office Setup Disk

24.1.6 Last Revision Date

Þ Enter the date the setup disk was created. This date appears on the Clublink Opening Screen. It is often used
to verify whether or not a club 's computer is configured for the current registration season.

See
Central Office Only
Creating a Central Office Setup Disk

24.1.7 Central Office Letter

Þ Certain sports use the Central Office Letter as a unique identifier in creating membership cards. If this box is
visible to you then you should contact your National body to obtain your Central Office Letter (often the first
letter of your province or state).

See
Central Office Only
Creating a Central Office Setup Disk
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24.1.8 Registration Year

Þ Enter the last two digits of the Registration Year for this setup disk. The Registration year is incorporated
into the membership card number of new members.

See
Central Office Only
Creating a Central Office Setup Disk

24.1.9 Membership Card

Membership card numbers are automatically generated for new members. The Membership card number is
unique to all members and stays with them year after year. Depending on your sport, the membership card
numbers are generated in one of three formats.
1. Numerical: A sequential number is assigned to the member. You may also assign a block of numbers to

designated clubs.
2. Central Office Letter: The membership number starts with the Central Office letter.
3. Default: Postal format. The membership number starts with the two character postal  province/state.

Þ Once you have reviewed and/or updated all aspects of the Central Office Setup Disk, click Create Files at
the bottom of the window.

Þ Select a drive for the files and click OK.  If you selected your C drive, you should make note of the location
of the file.

See
Central Office Only
Creating a Central Office Setup Disk

24.2 Distributing Central Office Setup Disk

Each club needs to receive the setup files. Contact us if you would like to include your Central Office Setup Disk
on our website for download with easy to follow installation instructions.

By email
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Þ Attach the files (located in your Clublink\FromMain folder) to an email.
Þ Send the email with instructions for the clubs to copy the files from the email to their Clublink\email folder

and then proceed with Receiving Central Office Setup Disk.

By CD

Þ Copy the files (located in your Clublink\FromMain folder) to the CD.  Repeat this for each club.
Þ Send a Setup Disk to each club.

+Note+:  When distributing your Central Office Setup Disk  we recommend that you include a document
describing your Linked Registration Options and Fee structure, Required and Requested Information, and any
changes from the previous season.

See
Central Office Only
Creating a Central Office Setup Disk

24.3 Club Information Management

The Central Office needs to Add any new clubs to the system before importing club data for registration.

See
Central Office Only
Adding a Club
Modifying a Club
Deleting a Club

24.3.1 Adding a Club

Þ Click the Clubs button on the Opening screen.
Þ From the Order drop box on the toolbar, select Number.
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Þ Check the bottom of the club list to see what club number should come next. Clublink will automatically get
the next highest club number if a numeric club numbering system is used.

Þ Click the Add button at the bottom of the window.
Þ Complete the tabbed pages of club information.

+Note+:  You will need to assign a club number on the Postal tab page.  You can also enter the Registration
Status and Expiry.  Alternatively, you may want to wait until the club has sent it's registration and fee before
changing it's registration status.

See
Club Information Management

24.3.2 Modifying a Club

Þ Click the Clubs button on the Opening screen.
Þ Select the appropriate club.
Þ Click the Modify button at the bottom of the window.
Þ Make the necessary changes on each of the tabbed pages.
Þ Click OK to save your changes.

See
Club Information Management
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24.3.3 Deleting a Club

Deleting a club will delete all of the club's information from Clublink.  We recommend that you deselect the
Active box on the Postal tab page of a club to make them inactive rather than completely deleting them from
your system.

To Delete:
Þ Click the Clubs button on the Opening screen.
Þ Select the appropriate club.
Þ Click the Delete button at the bottom of the window.

See
Club Information Management

24.3.4 Club Mailing Address

The club mailing address  is often the same as the address entered on the Postal tabbed page. If you are
running Clublink in a multi-club environment, you can specify an alternate mailing address for a club. Some
reports use the information on the Postal tabbed page whereas some other reports will use the Mailing Address. If
you make a change to the club address, you will be asked if you would like to update the mailing address too.

24.4 Importing Data from a Club

Importing data from a club will update your Clublink with new members and changes to member information.
You may receive information regarding accidents, changes to certifications and registration fees for new
members.  Once you have imported this data and completed the verification form you will need to export data
back to the club providing them with a confirmation of registration. Clubs members remain not registered and
pending until they are confirmed by the Central Office.

Þ Select Import Club Data from the Central Office menu on the Opening screen.
Þ Select the appropriate location of your import files and click OK

or
Þ Drag n drop the registration file on to the Clublink Opening Screen.

See
Central Office Only
Error Report
Verification Form
Financial Statement
Updating Members

24.4.1 Error Report

Þ Review and/or print the Error Report.  This report shows you the registration fees due from the club and
any information that may be missing from their data.

+Note+: The club sees the same Error report before exporting their membership.
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Þ Close the Error Report.

See
Central Office Only
Importing Data from a Club

24.4.2 Verification Form

Þ In the Import Club Data window, click Show in the Verification section to view the updates.

+Note+:  When importing, you may be prompted with one of two types of messages from Clublink.

If Clublink finds the same member duplicated in the same role, then Clublink does not know which member
needs to be updated. You will have to make this decision yourself. Generally when this message appears, there
are unnecessary duplicates and the duplicate should be removed after the import process is complete.
If Clublink finds the same member in a different club, Clublink does not know if the member should be added to
the system a second time and therefore appear in both clubs or if the member has moved clubs. Press Yes to
move the member from one club to the other, press No to create a second instance of the member.
Þ You can choose to view the details for each member in the Import List by selecting On from the Details

menu.
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Þ The Action to be taken is shown between the Import List and the Clublink List.  If necessary, you can
change the action by clicking the Change button. Clublink examines the membership and determines
whether the member is a new member or if the existing member needs to be updated.

When you have finished reviewing the Import List, click Close.

See
Central Office Only
Importing Data from a Club
Multiple Members Found
Duplicate Member Found

24.4.2.1 Confirm Member Form

If Clublink finds the same member duplicated in the same role, then Clublink does not know which member
needs to be updated. You will have to make this decision yourself. Generally when this message appears, there
are unnecessary duplicates and the duplicate should be removed after the import process is complete.
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See
Verification Form
Duplicate Member Found

24.4.2.2 Duplicate Member Found

If Clublink finds the same member duplicated in the same role, then Clublink does not know which member
needs to be updated. You will have to make this decision yourself. Generally when this message appears, there
are unnecessary duplicates and the duplicate should be removed after the import process is complete.

See
Verification Form
Multiple Members Found
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24.4.3 Financial Statement

Þ Click Show in the Statement section to view or print the Financial Statement.

See
Central Office Only
Importing Data from a Club

24.4.4 Updating Members

Þ Click Update Files to complete the import.
Þ Click OK to add all the imported members to the Registration Button.
Þ Enlarge the Import Changes list to view or print the changes.
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Close the Import Club Data window.

See
Central Office Only
Importing Data from a Club

24.5 Exporting Data/Confirmation to a Club

When you export data to a club you are sending the updated data that the Central Office may have entered as well
as confirmation for the data that you imported from the club.  The confirmation will update the club's members
from Pending to Registered.

Þ Select Export Club Data from the Central Office menu on the Opening screen.
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Þ Select the club you want to export. If you are exporting multiple clubs to your National Body, select club
"000".

Þ You have one last chance to verifiy what required and requested information is about to be sent.

Þ Click Show to view the Error Report.  You are required to view the Error Report  before you can create
the export files.  You may also print this report by selecting Print from the File menu.

Þ You may also view the Export List by clicking Show.
Þ Check the Certifications box if you would like to include certification updates and check the

Accident Reports box if you would like to include accident report updates. By checking Certifications or
Accident Reports, the club will automatically be prompted to send these with their registration.

Þ Click Create Files.
Þ Select one of the options from the Export Method window.

+Note+:  Selecting to open the folder containing your export file will show you where the file has been created.
You will still need to send this file to the club (i.e. email, floppy disk, CD).

Þ Close the Export Club Data window.

See
Central Office Only

24.6 Fees

See
Central Office Only
Charging Fees to a Club
Invoicing a Club
Receiving Payments from a Club
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24.6.1 Charging Fees to a Club

At the Central Office you will need to use the data you are importing from each club to assess fees for that club.
This will allow you to track your registration income, apply payments from a club and create invoices.

Þ From the Opening screen click the Clubs button  and select a club.

Þ Click the Fees button  on the toolbar to open the club's Fees page.

Þ Click the Fee Assessments tab page and select the appropriate Account tab.
Þ Click the Add button.

Þ Enter an amount and use the bottom drop box to select a name for the Fee Assessment.
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+Note+:  If the Fee Assessment does not already exist in your system, you can add a new one by typing it in the
Details box at the top of this window.  The new Fee Assessment title will automatically be added to the drop list
for future use.

Click OK to complete the Fee Assessment.

See
Central Office Only
Fees

24.6.2 Invoicing a Club

Þ From the Opening screen click the Clubs button  and select a club.

Þ Click the Fees button  on the toolbar to open the club's Fees page.
Þ After you have assessed all necessary fees (see Charging Fees to a Club page ???) click the Invoice button

 on any of the three tabbed pages in the Fees window.
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Þ In the Invoice window, make the appropriate selections. (See Invoice Window for descriptions of Invoice
selections)

Þ Click OK when you have completed your selections.
Þ Select a printer or select PDF to print your invoice to PDF.

See
Central Office Only
Fees

24.6.3 Receiving Payments from a Club

When you receive money from a club, it must be applied to a Fee Assessment.  So, you have to have assessed
the club fees (see Charging Fees to a Club for instructions) in order to enter any payments.

Þ From the Opening screen click the Clubs button  and select a club.

Þ Click the Fees button  on the toolbar to open the club's Fees page.

Þ Click the Payments button  on any of the three tabbed pages.

Þ Enter the Date of the payment.
Þ Enter the Amount of the payment.
Þ Select the Payment Type.
Þ Click Next.
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Þ Select a Fee Assessment to apply the payment to, then click the Apply button .

+Note+:  You can apply a payment to more than one fee assessment by selecting another assessment and clicking
the Apply button again.

Þ The OK button will illuminate when you have applied the full amount of the payment.
Þ The Fees window will automatically show the Payments tabbed page for you to view the details of the

payment that you just received.
Þ Click Close to close the fees window.

+Note+:  For all other Fees information, see Fees)

See
Central Office Only
Fees

24.7 New Season

New Season should be performed at the Club level by following the Performing New Season instructions. In
addition, there is a Central Office New Season that should be performed.  The Central Office New Season
works the same as the club New Season except each action is performed on the list of clubs rather than the list of
members.  This process should be completed before importing any club data for the upcoming season.

See
Central Office Only
Performing Central Office New Season
New Season Option Descriptions
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24.7.1 Performing Central Office New Season

Þ Select New Season from the Central Office menu on the Opening screen.
Þ In the New Season window, select the operations you want performed for the New Season. (See New Season

Option Descriptions below)

When you have completed all your selections, click OK.

See
Central Office Only
New Season

24.7.2 New Season Option Descriptions

Set all clubs to Not Active – will remove all clubs from the Active list and change them to the Not Active list.

Set all clubs to Not Registered – will change all affiliation status lights from Green or Yellow to Red and clear
the expiry date.

Delete all paid transactions – will erase all transactions where the amount due is exactly equal to the amount
paid.  This process will remove unwanted financial information for the New Season and can be run throughout
the season.

Delete deposited receipts before… – a given date will remove all transactions that have been acknowledged as
deposited (have a deposit date) before a specified date. Deleting deposited receipts will enhance the performance
of Clublink and remove unwanted receipts. Set a deletion date to a reasonable date where you would not have to
justify a payment and it's details. Keeping receipts in Clublink for one year is reasonable provided you perform
annual backups of your software.
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Rename transaction details… – will rename fee descriptions by adding in the year of the fee to differentiate old
fee descriptions from current fees.

See
Central Office Only
New Season

25 Checklists

Here are some checklists to help you get the most out of Clublink.
See
Club Checklist
Central Office Checklist
Clublink Data Fields

25.1 Club Checklist

Clublink is a very flexible piece of software and can be customized to match the operations of your club.
Complete the checklist to ensure you get the most out of Clublink's flexibility.

o Select the language for Clublink (English / French). [Opening Screen, Options | Language from the menu].
o Enter a unique club id number (defined by your Central Office). [Opening Screen, Module | Club Level

from the menu].
o Define access passwords (Administrator and Read Only) (optional). [Opening Screen, Options |

Administrator Password].
o Receive your Central Office Setup Disk. [Opening Screen, Options | Receive Central Office Setup Disk].
o Import Central Office Data (if your Central Office sent you data, it will reduce your data entry drastically

by importing their data into your system). [Opening Screen, Options | Import Central Office Data].
o Customize Clublink's data fields (remove unwanted data fields from the registration forms and customize the

titles of custom edit and list boxes). [Base Level, Setup | Data Fields Options].
o Review the Required and Requested data fields setup by your Central Office. [Base Level, Setup | Central

Office Data Field Options].
o Build your own Custom Drop Boxes (bottom two drop-down boxes on the General tabbed page and the

Registration Form). [Base Level, Lists | Custom Drop Boxes]. (see the Getting Started Guide).
o Set up your Tax System [Base Level, Options | Tax System].
o Assign your club fees in conjunction with the Central Office registration fee structure. [Base Level, Lists |

Linked Registration Options].
o Build your own Certifications (ex: NCCP). [Base Level, Setup | Certifications].

· Remember to backup your data on a regular basis.
· Please read New Season to familiarize yourself with seasonal reset features of Clublink.

See
Checklists

25.2 Central Office Checklist

Clublink is a very flexible piece of software and can be customized to match the operations of all of the clubs in
your jurisdiction. Complete the checklist to ensure you get the most out of Clublink's flexibility.

o Select the language for Clublink (English / French). [Opening Screen, Options | Language from the menu].
o Define access passwords (Administrator and Read Only) (optional). [Opening Screen, Options |

Administrator Password].
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o Customize Clublink's data fields (remove unwanted data fields from the registration forms). [Base Level,
Setup | Data Fields Options].

o Define the Required and Requested data fields (information you will need to exchange with your clubs and
information you would like to exchange with your clubs). [Opening Screen, Central Office | Central Office
Data Field Options].

o Set up your Tax System [Base Level, Options | Tax System].
o Build your Linked Registration Options (the registration fee structure for all new members). [Opening

Screen, Central Office | Linked Registration Options].

· Only Linked Registration Options checked as Required can be edited from the Central Office menu. To edit
in-house Linked Registration Options, select [Base Level, Lists | Linked Registration Options].

o Build your Custom Drop Boxes (bottom two drop-down boxes on the General tabbed page and the
Registration Form). To build a list that you would like to send to the clubs [Base Level, Lists | Custom Drop
Boxes].

· Only Custom Drop Boxes checked as Required can be edited from the Central Office menu. To edit in-
house Custom Drop Box, select [Base Level, Lists | Custom Drop Boxes].

· As a rule of thumb, the Central Office does not Require any Custom Drop Boxes, to provide maximum
flexibility of Clublink at the club level.

o Build your own Certifications (ex: NCCP). [Opening Screen, Central Office | Certifications]. Place a lock
in any Certification structure you would like to include on your Central Office Setup Disk.

· Only locked Certifications will be sent to the clubs via the Central Office Setup Disk. To edit in-house
Certification structures, select [Base Level, Setup | Certifications].

o Build your Medical Template [Opening Screen, Central Office | Medical Template].
o Enter all of the clubs for your jurisdiction and assign unique club id numbers. [Opening Screen, Module |

Club Level from the menu].
o Build your Central Office Setup Disk. [Opening Screen, Central Office | Build Central Office Setup Disk].
o Export Club Data (if your have club data, export the data to each club to facilitate their data entry and

ensure data accuracy). [Opening Screen, Central Office | Export Club Data].

· Remember to backup your data on a regular basis.
· Please read New Season to familiarize yourself with seasonal reset features of Clublink.

See
Checklists

25.3 Clublink Data Fields

General

o    Title
o    Address
o    Apartment
o    City
o    Province
o    Postal Code
o    Level 1 and Level 1 Name
o    Level 2 and Level 2 Name
o    Level 3 and Level 3 Name
o    Level 4 and Level 4 Name
o    Level 5 and Level 5 Name
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o    Default Province
o    Default Area Code

Family

Contact 1

o    Last Name
o    First Name
o    Is the responsible adult (check box)
o    Occupation
o    Phone Number
o    Relationship

Contact 2

o    Last Name
o    First Name
o    Is the responsible adult (check box)
o    Occupation
o    Phone Number
o    Relationship

Affiliate

o    Age
o    Sex
o    Birth date
o    Today's age (calculated)
o    Age as of (calculated)
o    Age as of  (Date)
o    Membership card
o    Active (check box)
o    Renewal (check box)
o    Club Start Date
o    Club Current Date
o    Club End Date
o    PSO Start Date
o    PSO Current Date
o    PSO End Date

Photo

o    Date

Medical

o    Medicare Number
o    SIN Number
o    Height
o    Weight
o    Doctor's Last Name
o    Doctor's First Name
o    Doctor's Phone Number
o    Emergency Last Name
o    Emergency First Name
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o    Emergency Phone Number
o    Medical Note

Miscellaneous

o    Work Number
o    Fax Number
o    Extra Check Box 1
o    Extra Check Box 1 Name
o    Extra Check Box 2
o    Extra Check Box 2 Name
o    Extra Date Box 1
o    Extra Date Box 1 Name
o    Extra Date Box 2
o    Extra Date Box 2 Name
o    Extra Text Box 1
o    Extra Text Box 1 Name
o    Extra Text Box 2
o    Extra Text Box 2 Name
o    Additional Clubs
o    E-mail address
o    Employee (check box)

See
Checklists

26 Support

Integrated Sports Systems (ISS) Inc.
259 Marsh Ave

Pointe-Claire, Quebec, Canada
H9R 5Y2

phone: 514-398-0766
fax: 514-694-1106

e-mail: info@integratedsports.net

visit www.integratedsports.net for support, frequenty asked quesiton and our bulletin board

©2005 Integrated Sports Systems (ISS) Inc.

http://www.integratedsports.net
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